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About vSphere Storage Appliance Installation
and Administration

vSphere Storage Appliance Installation and Administration helps you to install and configure your environment
®
®
to deploy vSphere Storage Appliance. You use vSphere Storage Appliance to create a vSphere Storage
®
®
Appliance Cluster which enables VMware vSphere vMotion and VMware vSphere High Availability
without the need to install expensive SAN arrays.

Intended Audience
This information is intended for anyone who wants to quickly enable vSphere vMotion and vSphere High
Availability in their virtual environment. The information is for experienced Windows system
administrators who are new to virtual machine technology and datacenter operations and do not have the
knowledge or experience in creating virtual and clustered environments.
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Updated Information

This vSphere Storage Appliance Installation and Administration Guide is updated with each release of the
product or when necessary.
This table provides the update history of the vSphere Storage Appliance Installation and Administration Guide.
Revision

Description

EN-000835-05

In “Considerations for Brownfield Installation,” on page 23, corrected the file path.

EN-000835-04

Minor corrections.

EN-000835-03

Minor corrections.

EN-000835-02

n
n

EN-000835-01

n
n
n
n

n
n
n

n

n
n
n

EN-000835-00

VMware, Inc.

Removed the "Enable the VSA Manager Plug-In in the vSphere Web Client" section as it is no longer
relevant in the current version of the vSphere Web Client.
In “Enable VSA Access for the vSphere Web Client,” on page 38, corrected the tab name.
Added note in “Differences Between VSA Clusters and Storage Area Networks,” on page 16.
Removed supported configuration information and put it in the release notes.
In “Create a VSA Cluster,” on page 42, added a step after completion of a network redundancy
check to reconnect Ethernet ports.
In “VSA Cluster Requirements,” on page 20, added the text "With the greenfield installation, all
hosts use freshly installed ESXi, and have the default networking setup. With brownfield, you can
use existing hosts that have non-default vSwitches and port groups, but must manually
create/configure the port groups required by VSA."
Made correction to state that vCenter Server does not support having different versions of VSA
Clusters or upgrading each cluster individually.
Clarified procedure order in “Upgrade vSphere Storage Appliance Environment (5.1 and earlier),” on
page 39.
In “Uninstall VSA Manager,” on page 34, changed 'the VSA cluster status might become Offline,
and the cluster becomes unavailable' to 'the VSA cluster status might become Offline, and the VSA
storage becomes unavailable'.
In “Considerations for Brownfield Installation,” on page 23, corrected the port group names to VM
Network, Management Network, VSA-Front End, VSA-Back End, VSA-VMotion. Changed
config.evc.baseline to evc.config.baseline and config.evc to evc.config.
Added that VMware Virtual Center Management Webservices needs to be restarted after a change.
Changed references from Tomcat to references to VMware Virtual Center Management Webservices
throughout the document.
Minor revisions.

Initial release.
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Introduction to
vSphere Storage Appliance

1

®

VMware vSphere Storage Appliance (VSA) is a VMware virtual appliance that packages SUSE Linux
Enterprise Server 11 and storage clustering services. A VSA virtual machine runs on several ESXi hosts to
abstract the storage resources that are installed on the hosts and to create a vSphere Storage Appliance
cluster (VSA cluster).
This chapter includes the following topics:
n

“What Is a VSA Cluster?,” on page 9

n

“VSA Cluster Components,” on page 10

n

“VSA Cluster Architecture,” on page 11

n

“VSA Cluster Network Architecture,” on page 12

n

“How a VSA Cluster Handles Failures,” on page 14

n

“Differences Between VSA Clusters and Storage Area Networks,” on page 16

n

“VSA Cluster Capacity,” on page 17

What Is a VSA Cluster?
A VSA cluster leverages the computing and storage resources of several ESXi hosts and provides a set of
datastores that are accessible by all hosts within the datacenter.
An ESXi host that runs a vSphere Storage Appliance and participates in a VSA cluster is a VSA cluster
member. With vSphere Storage Appliance, you can create a VSA cluster with two or three VSA cluster
members. The status of the VSA cluster is online only when more than half of the members are online.
A VSA cluster enables the following features:
n

Shared datastores for all hosts in the datacenter

n

Replica of each shared datastore

n

vSphere vMotion and vSphere HA

n

Hardware and software failover capabilities

n

Replacement of a failed VSA cluster member

n

Recovery of an existing VSA cluster

Depending on a licensing model you use, you can have several clusters managed by a single vCenter Server.

VMware, Inc.
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VSA Cluster Components
vSphere components together with the required hardware setup and configuration form a VSA cluster.
A VSA cluster requires the following vSphere and vSphere Storage Appliance components:
ESXi Hosts

Two or three ESXi hosts version 5.0 or later. All hosts in the cluster must have
the same version of ESXi. You can also use existing hosts that have virtual
machines running on their local datastores.

vCenter Server

A physical or virtual machine that runs vCenter Server and manages all ESXi
hosts that participate in the VSA cluster. Starting with release 5.1.1,
vCenter Server can run locally on one of the ESXi hosts in the VSA cluster.
vCenter Server can also run remotely and manage multiple VSA clusters.

vSphere Client
Interfaces

The vSphere Web Client or the vSphere Client. The vSphere Web Client is a
Web application installed on a machine with network access to your vCenter
Server installation.
The vSphere Client is installed on a Windows machine with network access
to your ESXi or vCenter Server system installation.
Both interfaces enable you to manage the VSA cluster from the VSA
Manager tab.

vSphere Storage
Appliance

A VMware virtual appliance that runs SUSE Linux Enterprise Server 11 SP2
and a set of storage clustering services that perform the following tasks:
n

Manage the storage capacity, performance, and data redundancy for the
hard disks that are installed on the ESXi hosts

n

Expose the disks of a host over the network

n

Manage hardware and software failures within the VSA cluster

n

Manage the communication between all instances of
vSphere Storage Appliance, and between each
vSphere Storage Appliance and the VSA Manager

Only one vSphere Storage Appliance can run on an ESXi host at a time.

10

VSA Manager

A vCenter Server extension (plug-in) that you install on a vCenter Server
machine. After you install it, you can see the VSA Manager tab in the
vSphere Web Client or the vSphere Client. You can use VSA Manager to
monitor, maintain, and troubleshoot a VSA cluster.

VSA Cluster Member

An ESXi host that runs a vSphere Storage Appliance as a virtual machine.
This is a special type of virtual machine that is a functional member of a VSA
cluster that exposes a datastore and maintains a datastore replica.

VSA Cluster Service

A service that is installed with VSA Manager on the vCenter Server
computer, or separately on a variety of platforms, including Windows Server
2003, Windows Server 2008, Windows 7, Linux RH, and SLES. The service is
installed by default for all configurations, but is used in a VSA cluster with
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two members to act as a third member in case one of the VSA cluster
members fails. In such a case, the Online status of two out of three members
maintains the Online status of the cluster. The service does not provide
storage volumes for the VSA datastores.
Important VSA datastores (NFS) continue operating with I/O even if the
VSA cluster service stops working. However, simultaneous failure of one of
the VSA cluster members and of the VSA cluster service results in failure of
the VSA datastores, and the status of the cluster changes to Offline. Once this
happens, the NFS datastores will show as italicized and inaccessible, and any
Virtual Machines and data stored on those datastores will also be
inaccessible until the issue is resolved.
VSA Cluster Leader

A vSphere Storage Appliance that reports the status of the cluster to the VSA
Manager. All members of the cluster participate in an election process
through which they select the leader. The leader uses the cluster IP address
to communicate with the VSA Manager.

Ethernet Switches

Gigabit Ethernet and 10 Gigabit Ethernet switches provide the high-speed
network backbone of the VSA cluster.

VSA Cluster Architecture
The architecture of a VSA cluster includes the physical servers that have local hard disks, ESXi as the
operating system of the physical servers, and the vSphere Storage Appliance virtual machines that run
clustering services to create volumes that are exported as the VSA datastores via NFS.
vSphere Storage Appliance supports the creation of a VSA cluster with two or three members. A
vSphere Storage Appliance uses the hard disks of an ESXi host to create two volumes of the same size. It
exports one of the volumes as a datastore. The other volume is a replica of the volume that is exported by
another vSphere Storage Appliance from another host in the VSA cluster.

VSA Cluster with Three ESXi Hosts
A VSA cluster with three members has three VSA datastores and maintains a replica of each datastore. This
configuration does not require the VSA cluster service.

VSA Cluster with Two ESXi Hosts
A VSA cluster with two VSA cluster members uses an additional service called VSA cluster service. The
service participates as a member in the VSA cluster, but it does not provide storage. For the VSA datastores
to remain online, a VSA cluster requires that more than half of the members are also online. If one instance
of a vSphere Storage Appliance fails, the VSA datastores can remain online only if the remaining VSA
cluster member and the VSA cluster service are online.
A VSA cluster with two members has two VSA datastores and maintains a replica of each datastore.
In a simple configuration, the VSA cluster service can run on the vCenter Server machine.
When you use a single vCenter Server instance to manage multiple remote VSA clusters in a more complex
configuration, the VSA cluster service must always run on the same network of the two member VSA
cluster.
You can run the VSA cluster service on a variety of platforms in a physical or virtual machine. The
installation of that VSA Cluster Service is separated from the VSA cluster installation.
However, note that the installation of VSA Manager on vCenter Server always installs the VSA Cluster
Service, whether it is going to be used or not.

VMware, Inc.

11

vSphere Storage Appliance Installation and Administration

The following illustration shows a single vCenter Server that manages a combination of three member and
two member clusters. One two member cluster uses the VSA cluster service installed on vCenter Server
while the rest of the two member clusters have their own VSA cluster service.
VMware vCenter Server
VSA Manager

VSA cluster service

manage

VSA Cluster 1

VSA Cluster 2

VSADs 0

VSADs 1

VSADs 0

VSADs 1

VSA cluster
service 2

volume 1

volume 2
(replica)

volume 2

volume 1
(replica)

volume 1

volume 2
(replica)

volume 2

volume 1
(replica)

VSA 1

VSA 2

VSA 1

VSA 2

ESXi 1

ESXi 2

ESXi 1

ESXi 2

Two member cluster that uses the VSA cluster service
installed with vCenter Server

Two member cluster that uses the VSA cluster service
installed separately

VSA Cluster 3
Three member
cluster

volume 1

VSADs 0

VSADs 1

VSADs 2

volume 3
(replica)

VSA 1

volume 3
volume 2

ESXi 1

volume 1
(replica)

VSA 2

volume 2
(replica)

VSA 3
ESXi 3

ESXi 2

VSA Cluster Network Architecture
The physical network of a VSA cluster consists of Ethernet switches and network interface cards (NICs) that
are installed on each host.

Physical Network Architecture
Note All networking in a VSA environment must operate at speeds of 1G or higher in order for the
configuration to be supported.
All hosts in the VSA cluster must have two dual-port or four single-port network interface cards. You can
use a single Ethernet switch for the VSA cluster network. To ensure network redundancy, you should use
two Ethernet switches.
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The following illustrations depict network redundancy in a VSA cluster with 2 and 3 members.
Note The ESXi NFS client always uses the first port, also called vmnic0, for the network traffic. This is
important to remember when you have hybrid 1Gigabit Ethernet/10 Gigabit Ethernet network
configurations.
Figure 1‑1. Network Redundancy in a VSA Cluster with 2 Members
host 1
vSwitch 0

vSwitch 1

host 2
vSwitch 0

physical switch 1

vSwitch 1

physical switch 2

enterprise network

Figure 1‑2. Network Redundancy in a VSA Cluster with 3 Members
host 1
vSwitch 0

vSwitch 1

host 3

host 2
vSwitch 0

vSwitch 1

vSwitch 0

physical switch 1

vSwitch 1

physical switch 2

enterprise network

In a VSA cluster, the network traffic is divided into front-end and back-end traffic.
n

n

VMware, Inc.

Front-end network traffic
n

Communication between each VSA cluster member and the VSA Manager

n

Communication between ESXi and the VSA volumes

n

Communication between each VSA cluster member and the VSA cluster service in a two node VSA
cluster

n

vMotion traffic between the second switch and the hosts

Back-end network traffic
n

Replication between a volume and its replica that resides on another host

n

Clustering communication between all VSA cluster members for a three node cluster

n

Communication between each VSA member cluster in a three node VSA cluster
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Logical Network Architecture
Each vSphere Storage Appliance has two virtual NICs: one handles the front-end traffic, and the other
handles back-end traffic. The back-end virtual NIC has an IP address from a private subnet. The front-end
virtual NIC can have up to 3 assigned IP addresses.
n

IP address for VSA management network

n

IP address of the exported NFS volume

n

IP address of the VSA cluster (assigned only when the VSA cluster member is elected as the cluster
leader)

The IP address of the VSA cluster can move between VSA cluster members. It is assigned to the front-end
virtual NIC of a VSA cluster member only when that VSA cluster member is elected as the cluster leader. If
the cluster leader becomes unavailable, the VSA cluster IP address is assigned to another VSA cluster
member that becomes the leader.
Two vSphere standard switches on each ESXi host isolate front-end and back-end traffic. The physical NIC
ports act as uplinks for each vSphere standard switch so that each NIC handles either front-end or back-end
traffic. The standard switches use ESXi NIC teaming to provide link failover.
The following illustration depicts the logical network of a VSA cluster member that is the leader in the VSA
cluster. The logical network of other VSA cluster members is the same with the exception of the assigned
VSA cluster IP address.
Figure 1‑3. Logical Network Architecture of a VSA Cluster Member
NIC 0
(front end)
VSA
virtual
machine

Virtual
Machine
2

Front end
virtual switch
NIC 0
(dual-port)

ESXi management network
vmnic 0
NIC 1
(back end)

Virtual
Machine
1

Front end
port groups

VSA front end network
vmnic 2
VM network

VSA back end network

ESXi feature network

vmnic 1
vmnic 3

vMotion. HA
Back end
Back end
port groups
virtual switch

NIC 1
(dual-port)
virtual switch

physical layer

How a VSA Cluster Handles Failures
A VSA cluster provides automatic failover from hardware and software failures.
Each VSA datastore has two volumes. A VSA cluster member exports the main volume as the VSA
datastore. Another VSA cluster member maintains the second volume as a replica. If a failure occurs to the
hardware, network equipment, or the VSA cluster member of the main volume, the main volume becomes
unavailable, and the replica volume takes its place without service interruption. After you fix the failure and
bring the failed VSA cluster member back online, the member synchronizes the main volume with the
replica to provide failover in case of further failures.
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A VSA cluster provides automatic failover from the following failures:
n

Failure of a single physical NIC or port, or a cable connecting the NIC port to its physical switch port

n

Single physical switch failure

n

Single physical host failure

n

Single VSA cluster member failure

The following illustration depicts automatic failover in a VSA cluster with 2 members. The replica volume
takes over the failed main volume. In this case, to make sure that more than half of the members are online,
the VSA cluster service simulates a VSA cluster member.
Figure 1‑4. Failover in a VSA Cluster with 2 Members
vCenter Server

VSA Manager

VSA Cluster Service

manage

VSADs-1

VSADs-0

volume 1

volume 2
(replica)

volume 2

volume 1
(replica)

VSA 1

VSA 2

ESXi 1

ESXi 2

The following illustration depicts failover in a VSA cluster with 3 members.
Figure 1‑5. Failover in a VSA Cluster with 3 Members
vCenter Server
VSA Manager

manage
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Differences Between VSA Clusters and Storage Area Networks
A VSA cluster is a virtual alternative to expensive SAN systems. While SAN systems provide centralized
arrays of storage over a high-speed network, a VSA cluster provides a distributed array that runs across
several physical servers and utilizes local storage that is attached to each ESXi host.
Note Since any storage media can be subject to catastrophic failure requiring complete replacement, a VSA
environment’s virtual machines and user data should always be periodically backed up to media external to
the VSA environment. The definition of acceptable frequency of such backups is outside the scope of this
document and is left to customer management discretion. For more information on this topic, please consult
the VMware Knowledge base or contact VMware Technical Support.

Centralized or Distributed Storage
SAN systems provide centralized arrays of storage that are managed by several storage processors. The
vSphere Storage Appliance provides a distributed approach to storage, where the storage array is dispersed
over several ESXi hosts and is accessible over the network.
Figure 1‑6. Centralized Storage Arrays in Comparison with Distributed Shared Storage
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volume replica
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redundant
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across servers

enclosure 1
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Local Storage or Networked Storage
In a typical storage configuration, your host uses local storage disks, or has access to networked storage. A
VSA cluster utilizes the hard disks that are local to each ESXi host.
Local storage

Local storage can be internal hard disks located inside your ESXi host, or it
can be external storage systems located outside and connected to the host
directly through protocols such as SAS or SATA. Typically, local storage does
not require a storage network to communicate with your host.
Local storage devices do not support sharing across multiple hosts. A
datastore on a local storage device can be accessed by only one host.

Networked storage

Networked storage consists of external storage systems that your ESXi host
uses to store virtual machine files remotely. Typically, the host accesses these
systems over a high-speed storage network.
Networked storage devices are shared. Datastores on networked storage
devices can be accessed by multiple hosts concurrently.

VSA Cluster Capacity
The total capacity of a VSA cluster is the sum of the capacities of all VSA datastores. Depending on the
RAID configuration of your VSA cluster, you use different algorithms to calculate VSA capacity.
Refer to the 5.1.1 Release Notes for supported disk and RAID combinations.

VMware, Inc.
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Installing and Configuring the VSA
Cluster Components

2

Before you can create a VSA cluster, you must prepare your environment by installing and configuring the
hardware and software components.
This chapter includes the following topics:
n

“vSphere Storage Appliance Planning Checklist,” on page 19

n

“VSA Cluster Requirements,” on page 20

n

“Configure RAID on a Dell Server,” on page 26

n

“Configure RAID on an HP Server,” on page 27

n

“Configure VLAN IDs on the Ethernet Switches,” on page 27

n

“ESXi Installation and Configuration,” on page 28

n

“vCenter Server Installation,” on page 31

n

“Create a Datacenter and Add Hosts in the vSphere Client,” on page 31

n

“Create a Datacenter and Add Hosts in the vSphere Web Client,” on page 32

n

“Install VSA Manager,” on page 33

n

“Uninstall VSA Manager,” on page 34

n

“Installing and Running VSA Cluster Service,” on page 35

n

“Enable VSA Access for the vSphere Web Client,” on page 38

n

“Enable the VSA Manager Plug-In in the vSphere Client,” on page 39

n

“Upgrade vSphere Storage Appliance Environment (5.1 and earlier),” on page 39

vSphere Storage Appliance Planning Checklist
You should decide on the scale and capacity of the VSA cluster and also consider some setup limitations.
n

n

VMware, Inc.

Install vCenter Server on a physical host or in a virtual machine on an ESXi host. The host that runs
vCenter Server can be a part of the VSA cluster.
n

vCenter Server must be installed and running before you create the VSA cluster.

n

If you run vCenter Server on a VSA datastore and the datastore goes offline, you will not be able to
manage the VSA cluster due to the loss of access to vCenter Server and VSA Manager. This is not a
supported configuration.

Decide on 2-member or 3-member VSA cluster. You cannot add another VSA cluster member to a
running VSA cluster. For example, you cannot extend a 2-member VSA cluster with another member.
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n

Determine the capacity of the VSA cluster before installation.
The VSA cluster requires RAID volumes created from the physical disks. The vSphere Storage
Appliance uses RAID1 to maintain the VSA datastores’ replicas. See the 5.1.1 Release Notes for
supported disk and RAID combinations.

n

Determine the number of virtual machines that will run in the VSA cluster.
n

Consider the vSphere HA admission control reservations when determining the number of virtual
machines and the amount of resources that your cluster supports. vSphere HA admission control
reserves 33% of all CPU and memory resources in a 3-member VSA cluster and 50% of all CPU and
memory resources in a 2-member cluster. vSphere HA admission control makes the reservations to
ensure that resources are available when virtual machines need to be restarted from a failed ESXi
host onto a running ESXi host.

n

The VSA cluster that includes ESXi version 5.0 hosts does not support memory overcommitment
for virtual machines. Because of this, you should reserve the configured memory of all non-VSA
virtual machines that use VSA datastores so that you do not overcommit memory. For virtual
machines that are not stored on the VSA datastores, you can skip this step. For more information
about preventing memory overcommitment, see the VMware vSphere Storage Appliance
Administration document.
If all cluster members run ESXi version 5.1, the VSA cluster supports memory overcommitment.

VSA Cluster Requirements
Make sure that your environment meets the hardware and configuration requirements to create a VSA
cluster.
Ensure that you have the hardware resources needed to install a VSA cluster.
n

Physical or virtual machine that runs vCenter Server. Starting with Release 5.1.1, you can run vCenter
Server on one of the ESXi hosts in the VSA cluster.

n

Two or three physical hosts with ESXi installed. The hosts networking must be all the same type of ESXi
installation, either greenfield or brownfield. With the greenfield installation, all hosts use the freshly
installed ESXi and have the default networking setup. With brownfield, you can use existing hosts that
have non-default vSwitches and port groups, but you must manually create and configure the port
groups required by VSA. VSA does not support combining freshly installed ESXi and modified ESXi
hosts in a single cluster.

n

At least one Gigabit Ethernet or 10 Gigabit Ethernet switch.

Requirements for vCenter Server in a VSA Cluster
Make sure that you run vCenter Server on a machine that meets the requirements for the VSA cluster.
You can install vCenter Server on a physical server or on a virtual machine. Make sure that the machine that
you choose meets the vCenter Server hardware requirements to operate in a VSA cluster. The vCenter Server
virtual machine can run on an ESXi host that is a part of the VSA cluster.
For detailed information about vCenter Server requirements, see the vSphere Installation and Setup
documentation.
For additional requirements specific to VSA installation, see “VSA Manager System and Software
Requirements,” on page 21.
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VSA Manager System and Software Requirements
The vCenter Server computer that you use for the VSA Manager installation must meet several requirements
specific to VSA.
In addition to general vCenter Server requirement, certain specific requirements apply to the system where
you install VSA Manager.

Supported Operating Systems
n

Windows Server 2003 Standard, Enterprise, or Datacenter 64-bit (SP2 required)

n

Windows Server 2003 R2 Standard, Enterprise, or Datacenter 64-bit (SP2 required)

n

Windows Server 2008 Standard, Enterprise, or Datacenter 64-bit

n

Windows Server 2008 Standard, Enterprise, or Datacenter 64-bit SP2

n

Windows Server 2008 Standard, Enterprise, or Datacenter 64-bit R2

Software Requirements
You install VSA Manager on the vCenter Server system.
n

vCenter Server 5.0/5.1

n

vCenter Server 5.0/5.1 Java Runtime Environment 1.6 (installed during vCenter Server installation)

n

VMware Virtual Center Management Webservices (installed during vCenter Server installation)

n

Windows Installer 4.5 or higher

n

Microsoft .NET Framework 3.5 SP1

n

Internet Explorer 7 or higher

n

Latest version of Adobe Flash for Internet Explorer

Hard Disk Space Requirements
Make sure that you have sufficient disk space to install VSA Manager. If you install the VSA cluster service
on the same server where you install VSA Manager, additional space is required.
Table 2‑1. Hard Disk Space Requirements
Component

Hard Disk Space Requirements

VSA Manager

10GB

VSA Cluster Service

2GB

Port Requirements
VSA Manager installation adds exceptions to the Windows Firewall. Make sure that the ports required by
VSA Manager are available.
Table 2‑2. Port Number Exceptions that VSA Manager adds to Windows Firewall
VSA Manager Service

TCP Port Number

VSA Cluster Client Port

4330

VSA Cluster Server Port

4331

VSA Cluster Election Port

4332

VSA RMI Port

4333
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Table 2‑2. Port Number Exceptions that VSA Manager adds to Windows Firewall (Continued)
VSA Manager Service

TCP Port Number

VSA JMS SSL Port

4334

VSA JMS Port

4335

VSA HTTPS Port

4336

VSA Upgrade Port1

4337

VSA Upgrade Port2

4338

VSA Upgrade Port3

4339

Windows Privileges Requirements
To install the VSA Manager 5.1, you must be a local administrator or a domain user with local
administrative privileges.

Hardware Requirements for ESXi in a VSA Cluster
You can have two or three ESXi hosts in a VSA cluster. Each host must meet the hardware configuration
requirements to join a VSA cluster.
Table 2‑3. VSA Cluster Requirements for ESXi Hosts
Hardware

VSA Cluster Requirements

Configuration

All ESXi hosts must have the same hardware configuration.

CPU

n
n

Memory

n
n
n
n

64-bit x86 CPUs
2GHz or higher per core
6GB, minimum
24GB, recommended
72GB, maximum supported
1TB, maximum supported by ESXi

NIC

4 NIC ports must be available on each ESXi host. You can meet this requirements with one, two,
three, or four Gigabit or 10Gb Ethernet NICs per ESXi host. To achieve NIC redundancy, you
should have at least two Ethernet adapters on an ESXi host. Installing more than two NICs
depends on the availability of embedded NICs and additional PCI Express slots on the
motherboard. The following NIC combinations are supported:
n 4 single-port NICs
n 2 dual-port NICs
n 2 single-port NICs and 1 dual-port NIC
n 1 quad-port NIC (does not provide NIC redundancy)
You can have more than 4 NIC ports per ESXi host but not less than 4.

Hard disks

Supported configurations
See the 5.1.1 Release Notes for supported disk and RAID combinations.
Non-supported configurations
n A combination of SATA and SAS disks is not supported
n JBOD is not supported
n

RAID controller
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A RAID controller
Note See the 5.1.1 Release Notes for supported disk and RAID combinations.
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Software Configuration Required for ESXi in a VSA Cluster
Make sure that the ESXi hosts meet the software requirements to join a VSA cluster.
Table 2‑4. ESXi Software Configuration Requirements for a VSA Cluster
Configuration

VSA Cluster Requirements

ESXi version

Each host must have ESXi 5.0 or later installed.

ESXi license

For trial installations of the VSA cluster, you can run ESXi
in evaluation mode.
For licensed installations, the license model you use
depends on whether you plan to manage a single VSA
cluster or multiple clusters.

Cluster configuration

None of the ESXi hosts must participate in another cluster.

vSphere standard switch and port group configuration

If you use newly installed ESXi hosts for your cluster,
standard vSwitches and port groups are created during the
VSA cluster installation. If you use existing hosts that have
preconfigured vSwitches, the VSA cluster installer audits
the vSwitches.
Note Make sure that the name of the VMkernel port
group is Management Network. VSA Manager uses this
name to retrieve host network information.

IP address

Each ESXi host must be assigned a unique static IP address.
Note vCenter Server and the VSA cluster can be on
different subnets.

Virtual machines

VSA supports creating a VSA cluster on ESXi hosts that
have running virtual machines. After you create the cluster,
move the virtual machines that reside on the hosts' local
VMFS datastores to the VSA datastores. The only virtual
machine that must remain on the local VMFS volume is the
vCenter Server virtual machine. This allows you to avoid
resource contention between VSA virtual machines and
non-VSA virtual machines.

Considerations for Brownfield Installation
With brownfield installation, you deploy vSphere Storage Appliance and create a VSA cluster on existing
ESXi hosts that have virtual machines running on their local datastores. The brownfield installation
contrasts with the greenfield installation when you use hosts with freshly installed ESXi.
After you perform the brownfield deployment, migrate virtual machines from local storage to VSA shared
storage. The only virtual machine that can run on the local datastore is the vCenter Server virtual machine.
You can then resize shared storage and add storage capacity to the VSA.

Installation with Running Virtual Machines
When ESXi hosts contain running virtual machines, the following considerations apply:
n

The Enhanced vMotion Capability (EVC) baseline you specify must be a superset of the EVC of the
ESXi host with running virtual machines. By default, the EVC baseline is set to the lowest possible value
to maximize the types of hosts that the cluster can support.
n
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If running virtual machines are present on the ESXi host, they are using features on the CPU. You
must power off virtual machines, or set the evc.config.baseline property in the C:\Program
Files\VMware\Infrastructure\tomcat\webapps\VSAManager\WEB-INF\classes\Dev.Properties file
to highest. This guarantees that the lowest common denominator of EVC baselines is used (highest
possible).
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n

If your configuration does not allow to enable the EVC mode on the HA cluster, disable the EVC
mode by setting the evc.config property to false in the C:\Program
Files\VMware\Infrastructure\tomcat\webapps\VSAManager\WEB-INF\classes\Dev.Properties file.
You can later manually enable EVC for the cluster. For information, see
http://kb.vmware.com/kb/1013111. The EVC mode must be enabled on the cluster to avoid vMotion
compatibility issues.

Note When you need to replace a cluster member in a VSA cluster, do not use an ESXi host with
running virtual machines as a replacement host. Make sure to power off or migrate any running virtual
machines on the replacement host, otherwise the host will not be able to join the VSA HA cluster.
For more information on EVC, see the vCenter Server and Host Management.

Network Configuration
When networking configuration on ESXi hosts has been changed, or if you need to manually configure the
NICs selected for different portgroups, the following consideration apply:
n

Each ESXi host must contain at least one vSwitch.

n

Configure five port groups on each host, named exactly as follows: VSA-Front End, VM Network,
Management, VSA-Back End, VSA-VMotion.
n

For each port group, configure NIC teaming so that it has at least one active and one standby NIC.

n

If the NIC is active for the Management and VM Network port groups, it should not be active for
VSA-Front End port group. Use the standby NIC instead.

n

If the NIC is active for port group VSA-Back End, it should not be active for the VSA-VMotion port
group. You can use the standby NIC.

n

Corresponding port groups across hosts should have the same VLAN ID.

Network Switch Requirements for a VSA Cluster
The VSA cluster network must have at least 1 dedicated Ethernet switch that supports IEEE 802.1Q VLAN
trunking.
You can have 2 dedicated switches to eliminate a single point of failure in the physical network. The
switches must be configured to support the IP ranges of the front-end and back-end networks of the VSA
cluster. To isolate front-end and back-end networks, you should use VLANs instead of physical isolation.
VLAN isolation protects the VSA virtual NICs from Ethernet broadcast storms and malicious capturing and
parsing of Ethernet frames. If VLANs are to be used with the VSA Cluster, all of the NICs must go into
trunking ports.
You can configure two VLAN IDs on your switches to isolate traffic between the front-end and back-end
networks. You can use the VLAN IDs in the VSA Installer and VSA Automated Installer to specify the
VLAN IDs for the front-end and back-end networks. Using VLAN IDs is not mandatory.
A VSA back-end VLAN isolates VSA private network traffic and VSA front-end network traffic from
network traffic initiated by non-VSA virtual machines on the VM Network port group. The private network
includes clustering and RAID1 replication for a three-node VSA cluster and RAID1 replication only for a
two-node VSA cluster. In addition, the vMotion network traffic is routed over the front-end VLAN even
though it is directed to the back-end vSwitch.
Note VLAN IDs can range from 1 to 4094. You cannot use 0 and 4095.
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Table 2‑5. VLAN ID Configuration for a VSA Cluster
VSA Cluster Network

Example VLAN ID

Front-end network

1337

Back-end network

3598

IP Address Requirements for a VSA Cluster
The VSA cluster network requires a number of static IP addresses. Depending on the number of hosts in the
cluster and whether you choose to use DHCP for the vSphere feature network, the number of required static
IP addresses varies.
vCenter Server and VSA Manager do not need to be in the same subnet as VSA clusters. Members of each
VSA cluster, including the VSA cluster service for a 2-member configuration, need to be in the same subnet.
The following table shows examples and the total number of static IP address that you need for various VSA
cluster configurations.
Note For a 2-member VSA cluster with a simple configuration, you do not need an extra static IP for the
VSA cluster service. You can use the IP address of vCenter Server as the IP for the VSA cluster service.
Table 2‑6. Examples of Static IP Addresses for Different VSA Cluster Configurations
VSA Cluster
Component

2-Member Cluster
Without DHCP

2-Member Cluster With
DHCP

3-Member Cluster
Without DHCP

3-Member Cluster With
DHCP

Number of
static IP
addresses in
the same
subnet

11

9

14

11

Number of IP
addresses in a
private
subnet for the
back-end
network

2

2

3

3

vCenter
Server IP
address

10.15.20.100

10.15.20.100

10.15.20.100

10.15.20.100

ESXi host 1 IP
address

10.15.20.101

10.15.20.101

10.15.20.101

10.15.20.101

ESXi host 2 IP
address

10.15.20.102

10.15.20.102

10.15.20.102

10.15.20.102

ESXi host 3 IP
address

N/A

N/A

10.15.20.103

10.15.20.103

VSA cluster
IP address

10.15.20.103

10.15.20.103

10.15.20.104

10.15.20.104

VSA cluster
service IP
address

10.15.20.104

10.15.20.104

N/A

N/A

Management
IP address for
VSA 1

10.15.20.105

10.15.20.105

10.15.20.105

10.15.20.105

Datastore IP
address for
VSA 1

10.15.20.106

10.15.20.106

10.15.20.106

10.15.20.106
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Table 2‑6. Examples of Static IP Addresses for Different VSA Cluster Configurations (Continued)
VSA Cluster
Component

2-Member Cluster
Without DHCP

2-Member Cluster With
DHCP

3-Member Cluster
Without DHCP

3-Member Cluster With
DHCP

Back-end IP
address for
VSA 1

192.168.0.1

192.168.0.1

192.168.0.1

192.168.0.1

vSphere
feature IP
address for
ESXi host 1

10.15.20.107

10.15.20.201, dynamically
assigned IP address
Note DHCP assigns an IP
address according to the
range of IP addresses
assigned to the DHCP
server.

10.15.20.107

10.15.20.201, dynamically
assigned IP address
Note DHCP assigns an IP
address according to the
range of IP addresses
assigned to the DHCP
server.

Management
IP address for
VSA 2

10.15.20.108

10.15.20.107

10.15.20.108

10.15.20.107

Datastore IP
address for
VSA 2

10.15.20.109

10.15.20.108

10.15.20.109

10.15.20.108

Back-end IP
address for
VSA 2

192.168.0.2

192.168.0.2

192.168.0.2

192.168.0.2

vSphere
feature IP
address for
ESXi host 2

10.15.20.110

10.15.20.202, dynamically
assigned IP address
Note DHCP assigns an IP
address according to the
range of IP addresses
assigned to the DHCP
server.

10.15.20.110

10.15.20.202, dynamically
assigned IP address
Note DHCP assigns an IP
address according to the
range of IP addresses
assigned to the DHCP
server.

Management
IP address for
VSA 3

N/A

N/A

10.15.20.111

10.15.20.109

Datastore IP
address for
VSA 3

N/A

N/A

10.15.20.112

10.15.20.110

Back-end IP
address for
VSA 3

N/A

N/A

192.168.0.3

192.168.0.3

vSphere
feature IP
address for
ESXi host 3

N/A

N/A

10.15.20.113

10.15.20.203, dynamically
assigned IP address
Note DHCP assigns an IP
address according to the
range of IP addresses
assigned to the DHCP
server.

Configure RAID on a Dell Server
For Dell servers, you use the Dell PowerEdge RAID Controller (PERC) to create a RAID volume that uses all
physical disks on a server.
Note Refer to the 5.1.1 Release Notes for supported disk and RAID combinations.
Procedure
1
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Start or restart the Dell PowerEdge server.
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2

Press Ctrl+R to access the Perc 6/I Integrated BIOS Configuration Utility.
The configuration utility opens and shows the VD Mgmt tab.

3

To create a new virtual disk, press F2 and select Create New VD.

4

Select an appropriate RAID configuration from the RAID Level drop-down menu.

5

Under Physical Disks, select the hard disks that you want to include in the virtual disk.

6

Select OK and press Enter.
The virtual disk is created.

7

Expand the Disk Group option, and under Virtual Disks, select the newly created virtual disk and press
F2 to open the Operations menu.

8

From the Operations menu, select Initialization > Start Init. to initialize the new virtual disk.

The new RAID volume is ready for use.

Configure RAID on an HP Server
Create a RAID logical volume that uses all physical disks on a server.
Note Refer to the 5.1.1 Release Notes for supported disk and RAID combinations.
Procedure
1

Start or restart the HP server.

2

At boot time, press F8 to enter the Integrated Lights-Out 2 setup.

3

Provide credentials at the login prompt.

4

Press Ctrl+S to open the Intel Boot Agent Setup Menu.

5

Press F8 to open the ROM Array Configuration menu.
The Main Menu appears.

6

From the Main Menu, select Create Logical Drive and press Enter.

7

Select all physical disks under Available Physical Drives.

8

Select an appropriate RAID level under RAID Configurations.

9

Press Esc.

The HP RAID controller creates the RAID logical drive.

Configure VLAN IDs on the Ethernet Switches
To make use of traffic isolation, you should configure separate VLAN IDs for the front end and back end
networks of the VSA cluster.
Note Using VLAN IDs is not mandatory.
Procedure
1

Read the documentation for your Ethernet switch for information about how to configure VLAN IDs.

2

Work with your network administrator to assign VLAN IDs for the front end and back end networks.
A VLAN ID should range from 1 to 4094, as 0 and 4095 are not allowed.
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The assigned VLAN IDs are ready to be assigned to the ESXi hosts and to the VSA cluster network.
Note The VLAN must not be assigned to specific NIC ports.

ESXi Installation and Configuration
All host that you plan to include in a VSA cluster must have ESXi of the same version installed.
For detailed information about ESXi installation requirements and process, see the vSphere Installation and
Setup documentation.

Configure the ESXi Hosts
You must configure the ESXi hosts before they can join the VSA cluster.
Prerequisites
Install ESXi 5.0 or later on each host that you plan to include in a VSA cluster. For details, see the vSphere
Installation and Setup documentation.
Procedure
1

Log In to an ESXi Host on page 28
Log in to an ESXi host to configure it.

2

Change the root Password of an ESXi Host on page 29
The root password is emtpy when you log in for the first time. To improve the security of your ESXi
host, change the default password after you log in for the first time.

3

Assign a Static IP Address to an ESXi Host on page 29
Each ESXi host in the VSA cluster must have a unique static IP address.

4

Assign a VLAN ID to an ESXi Host on page 30
To isolate the management traffic of the ESXi hosts within the VSA cluster network, assign the same
VLAN ID to each ESXi host that you want to add to the VSA cluster. Using VLANs is optional.

5

Specify a Hostname and DNS Servers for an ESXi Host on page 30
To enable DNS resolution on your ESXi hosts, add DNS servers to the ESXi network settings.

6

Test the Management Network of an ESXi Host on page 30
After you configure the ESXi host network settings, you can test the management network of the host
to verify that it is working correctly.

Log In to an ESXi Host
Log in to an ESXi host to configure it.
Procedure
1

Connect to the management interface of your ESXi host and run the remote console.

2

In the remote console window, press F2 and log in with root credentials.
If you are logging in for the first time, the root password is empty.

The System Customization menu opens.
What to do next
Change the root password for the ESXi host.
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Change the root Password of an ESXi Host
The root password is emtpy when you log in for the first time. To improve the security of your ESXi host,
change the default password after you log in for the first time.
Procedure
1

In the System Customization menu of the ESXi host, use the keyboard arrows to select Configure
Password and press Enter.
The Configure Password dialog box appears.

2

Fill the required fields to change the password and press Enter.
Option

Action

Old Password

Type the old password of the ESXi host.

New Password

Type the new password for the ESXi host.

Confirm Password

Confirm the new password.

The root password for the ESXi host is changed.
What to do next
Configure the network settings of the ESXi host.

Assign a Static IP Address to an ESXi Host
Each ESXi host in the VSA cluster must have a unique static IP address.
The hosts are not required to be in the same subnet as vCenter Server. However, members of each VSA
cluster need to be in the same subnet.
Prerequisites
Work with your network administrator to allocate the static IP addresses that are required by the VSA
cluster.
Procedure
1

In the System Customization menu, select Configure Management Network and press Enter.

2

In the Configure Management Network menu, select IP Configuration and press Enter.

3

In the IP Configuration dialog box, select Set static IP address and network configuration and press the
spacebar.

4

Type the static IP configuration in the corresponding text boxes and press Enter.

5

Network Field

Action

IP Address

Enter a static IP address for the ESXi host.

Subnet Mask

Enter the subnet mask of the network to which the static IP address
belongs.

Default Gateway

Enter the gateway for the subnet.

Press Esc.
The Configure Management Network confirmation dialog box appears.

6
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Press Y to restart the management network and apply the new static IP address.
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ESXi configures the management network with the static IP address that you assigned.

Assign a VLAN ID to an ESXi Host
To isolate the management traffic of the ESXi hosts within the VSA cluster network, assign the same VLAN
ID to each ESXi host that you want to add to the VSA cluster. Using VLANs is optional.
Prerequisites
Note Using VLAN IDs is not mandatory.
Configure your Ethernet switches with the VLAN IDs that your ESXi hosts should use. If you are using
VLANs, the NICs must be on trunking ports.
Procedure
1

In the System Customization menu, select Configure Management Network by using the keyboard
arrows and press Enter.

2

In the Configure Management Network menu, select VLAN (option) and press Enter.

3

In the VLAN ID input text box, type the VLAN ID of the virtual LAN that your ESXi should use, and
press Enter.

The VLAN ID for the ESXi host is set.
What to do next
Configure DNS on each ESXi host.

Specify a Hostname and DNS Servers for an ESXi Host
To enable DNS resolution on your ESXi hosts, add DNS servers to the ESXi network settings.
Procedure
1

In the Configure Management Network menu, select DNS Configuration and press Enter.

2

In the DNS Configuration dialog box, use the keyboard arrows to select Use the following DNS server
addresses and hostname and press the spacebar.

3

Fill the required input fields to configure the DNS settings of the ESXi host and press Enter.
Option

Action

Primary DNS Server

Type the IP address of the primary DNS server of the ESXi host network.

Alternate DNS Server

Type the IP address of the secondary DNS server of the ESXi host network.

Hostname

Type the hostname of the ESXi host.

What to do next
You can test the network configuration of the ESXi host.

Test the Management Network of an ESXi Host
After you configure the ESXi host network settings, you can test the management network of the host to
verify that it is working correctly.
Prerequisites
Configure the ESXi host IP address, VLAN ID, and DNS servers.
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Procedure
1

In the System Customization menu, select Test Management Network and press Enter.
The Test Management Network dialog box appears. The dialog box contains the gateway IP address of
the subnet and the DNS servers that you specified.

2

To test if the ESXi host management network, press Enter.
ESXi performs the following tests:

3

n

pings the subnet gateway specified

n

pings the primary DNS server specified

n

pings the alternate DNS server specified

n

resolves the hostname of the ESXi host

If any of the tests fail, verify that you specified the correct settings in the respective configuration menu
and rerun the tests.

What to do next
Press Esc to log out of the ESXi system customization and close the remote console. You can now connect the
configured ESXi hosts to a vCenter Server.

vCenter Server Installation
vCenter Server allows you to centrally manage hosts from either a physical or virtual Windows machine,
and enables the management of a VSA cluster as well as the use of advanced features such as vSphere High
Availability (HA), vSphere vMotion, and vSphere Storage vMotion.
You can install vCenter Server on a separate 64-bit physical server. You can also install ESXi on that system
and deploy vCenter Server in a virtual machine within the host. The host that runs vCenter Server can be a
part of the VSA cluster.
Before you install vCenter Server, make sure your system meets the minimum hardware and software
requirements. vCenter Server requires a database. Refer to the vSphere Compatibility Matrixes for the list of
supported databases recommended for small or larger deployments.
Note If you run vCenter Server in a virtual machine, enable memory reservations on the virtual machine.
For information, see “Change Memory Reservations on a Virtual Machine in the vSphere Web Client,” on
page 52.
Install vCenter Server using the vCenter Server Simple Install option. You must also install the
vSphere Web Client, which lets you connect to a vCenter Server system to manage ESXi hosts through a
browser. For information about installing the vSphere Web Client, see the vSphere Installation and Setup
documentation.

Create a Datacenter and Add Hosts in the vSphere Client
Before you create a VSA cluster, you must create a datacenter and add ESXi hosts in vCenter Server.
You can create a VSA cluster with two or three ESXi hosts. The hosts that you add to the cluster can have
newly installed ESXi. You can also use existing hosts that have virtual machines running on their local
datastores. The number of available datastores in the VSA cluster equals the number of hosts that you add to
it. Creating a cluster with three hosts makes the cluster more reliable and provides more datastore space.
You can skip this procedure, if you use the VSA Automated Installer.
Note If you plan to use a single vCenter Server to manage multiple VSA clusters, create a separate
datacenter object for each VSA cluster.
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Procedure
1

Create a new datacenter.
a

In vSphere Client, select File > New > Datacenter.
A new datacenter object appears in the inventory.

b
2

Enter a name for the datacenter and press Enter.

Add hosts to the new datacenter.
a

Select the datacenter in the inventory.

b

Select File > New > Add Host.

c

On the Connection Settings page of the Add Host Wizard, enter the IP address and root credentials
of the ESXi host to add and click Next.

d

On the Host Summary page, review the information about the host and click Next.

e

On the Assign License page, select Assign a new license key to this host radio button if your ESXi
host does not have an assigned license, and assign a new license.

f

Click Next.

g

On the Virtual Machine Location page, select the datacenter you created and click Next.

h

On the Ready to Complete page, review your selections and click Finish.

i

Repeat steps from a to h to add another ESXi host.

What to do next
You can now create the VSA cluster by running the VSA Installer wizard.

Create a Datacenter and Add Hosts in the vSphere Web Client
Before you create a VSA cluster, you must create a datacenter and add ESXi hosts in vCenter Server.
You can create a VSA cluster with two or three ESXi hosts. The hosts that you add to the cluster can have
newly installed ESXi. You can also use existing hosts that have virtual machines running on their local
datastores.
Note After you create the cluster, move the virtual machines that reside on the hosts' local VMFS
datastores to the VSA datastores. The only virtual machine that can remain on the local VMFS volume is the
vCenter Server virtual machine.
The number of available datastores in the VSA cluster equals the number of hosts that you add to it.
Creating a cluster with three hosts makes the cluster more reliable and provides more datastore space.
You can skip this procedure, if you use the VSA Automated Installer.
Note If you plan use a single vCenter Server to manage multiple VSA clusters, create a separate datacenter
object for each VSA cluster.
Procedure
1

Create a new datacenter.
a

Browse to the vCenter Server system in the vSphere Web Client.

b

Click Actions > New Datacenter.

c

Enter a name for the datacenter and click OK.

A new datacenter object appears on the list of datacenters.
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2

Add hosts to the new datacenter.
a

Navigate to a datacenter and click the Add Host icon.

b

Type the IP address or the name of the host and click Next.

c

Type administrator credentials and click Next.

d

Review the host summary and click Next.

e

Assign a license key to the host.

f

Select Enable Lockdown Mode to disable remote access for the administrator account after
vCenter Server takes control of this host.
Selecting this check box ensures that the host is managed only through vCenter Server. You can
perform certain management tasks while in lockdown mode by logging into the local console on
the host.

g

If you add the host to a datacenter or a folder, select a location for the virtual machines that reside
on the host and click Next.

h

Review the summary and click Finish.

i

Repeat any applicable steps to add another ESXi host.

What to do next
You can now create the VSA cluster by running the VSA Installer wizard.

Install VSA Manager
VSA Manager is a plug-in for the vSphere Web Client that you use to create and manage a VSA cluster. VSA
Manager also installs the VSA cluster service on the vCenter Server machine or on a server of your choice.
You can install VSA Manager only on a 64-bit Windows Server machine that runs vCenter Server version 5.0
or later.
Prerequisites
Download the VSA Manager Installer.
Procedure
1

On the vCenter Server machine, start the VMware-vsamanager-en-version_number-build_number.exe file.

2

Take appropriate action on the Welcome and End-User Patent Agreement pages.

3

Select I accept the terms in the license agreement and click Next.
The vCenter Server Information page appears and VSA Manager installer automatically fills the
vCenter Server IP address or host name, and the HTTPS port of the vCenter Server machine.

4

On the VMware vCenter Server Information page, verify that the vCenter Server IP address or host
name is that of the local machine and click Next.
Caution Do not modify the vCenter Server ports because that might lead to VSA upgrade failures.

5

In the VCS User Information page, enter the user name and password and click Next.

6

On the License Information page, type an appropriate license key and click Next.
If you do not enter a key, VMware vSphere Storage Appliance runs in evaluation mode.
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7

Click Install on the Ready to Install page.
Wait for the wizard to complete the installation.

8

Click Finish.

VSA Manager plug-in is installed and registered with vCenter Server. The next time you connect to
vCenter Server and select a datacenter from the vCenter Server inventory, the VSA Manager tab appears.
You can use the VSA Manager tab to create and manage the VSA cluster.
What to do next
To be able to access the VSA Manager tab, make sure that the latest version of Adobe Flash is installed on
the vCenter Server system.
If you use the vSphere Web Client to connect to vCenter Server, enable VSA Access for the
vSphere Web Client.

Uninstall VSA Manager
You can uninstall VSA Manager if you have deleted the VSA cluster and no longer use the plug-in for
maintenance and monitoring.
When you uninstall VSA Manager while the VSA cluster is still running, the VSA Manager plug-in and the
VSA Manager tab are removed from vCenter Server and the VSA cluster service is stopped and deleted. As
a result, you can no longer use VSA Manager to monitor or reconfigure the VSA cluster. Also, in a 2-member
VSA cluster, the VSA cluster service can no longer provide an additional vote in the election of the VSA
cluster leader. In this case, the VSA cluster status might become Offline, and the VSA storage becomes
unavailable.
Important To ensure that a running 2-member VSA cluster is available and its status is Online, do not
uninstall VSA Manager. If you have a 3-member VSA cluster, the VSA cluster continues working without
interruption even if you uninstall VSA Manager.
Procedure
1

Open the list of programs on the Windows Server system that runs VSA Manager and vCenter Server.
Option

Description

Windows Server 2003

In Control Panel, select Add or Remove Programs.

Windows Server 2008

In Control Panel, under the Programs section select Uninstall a Program.

2

From the list of programs, select VMware vSphere Storage Appliance Manager and click Uninstall.

3

Click Yes in the confirmation dialog box.

The VSA Manager plug-in and the VSA cluster service are uninstalled. The VSA Manager tab no longer
appears when you select a datacenter object.
What to do next
When you uninstall VSA Manager, VSA's persistent data and logs located in %ALLUSERSPROFILE%\VMware\VSA

Manager remain intact.

If you later plan to reinstall VSA Manager and manage your old clusters again, do not delete contents of this
folder.
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Installing and Running VSA Cluster Service
The VSA cluster service is required by a VSA cluster with two members. You can install the service
separately on a variety of 64-bit operating systems, including Windows Server 2003, Windows Server 2008,
Windows 7, Red Hat Linux, and SUSE Linux Enterprise Server (SLES).
When you install the VSA cluster service separately, the following considerations apply:
The VSA cluster service installation requires 2GB of space.

n

n

The VSA cluster service must be on the same subnet as other cluster members.

n

Do not install more than one VSA cluster service on the same server.

n

Do not install the VSA cluster service on a virtual machine that runs on a VSA datastore.

n

The machine that hosts the VSA cluster service must have only one network interface and one IP
address.

n

All VSA cluster service logs are located in the $INSTALL_HOME/logs folder.

n

The VSA cluster service uses the following network ports for communication: 4330, 4331, 4332, 4333,
4334, 4335, 4336, 4337, 4338, 4339.
Before starting the service, make sure that these ports are not occupied by any other process.

n

If the VSA cluster service runs on a virtual machine, reserve 100% of the virtual machine memory. Also,
reserve at least 500MHz of CPU time. The reservation is required to avoid memory swapping that can
cause the virtual machine to pause for more than two seconds. This can result in the VSA cluster service
being disconnected from the cluster and the cluster becoming unavailable. For information about
enabling memory reservations, see “Change Memory Reservations on a Virtual Machine in the vSphere
Web Client,” on page 52.

Install VSA Cluster Service on Windows
Install the VSA cluster service separately on a Windows computer.
You can install the service on the following platforms:
Windows Server 2003
n
n

Windows Server 2008

n

Windows 7

Prerequisites
Obtain administrator privileges to install and run the service.
Procedure
1

Unzip the VMware-VSAClusterService-5.1.0-build#-win-jre.zip file into a permanent location.

2

Rename the created sub-folder VMwareVSAClusterService-5.1.0-build# to $INSTALL_HOME.

3

Manually disable the firewall to allow network traffic to reach the VSA cluster service.

4

Run $INSTALL_HOME/bin/setup.bat.
The script performs the initial setup work.

5

If IPv6 is enabled on the host, do one of the following:
n

Disable IPv6 on the host.

n

From the $INSTALL_HOME/conf/wrapper.conf file, delete the line that contains
wrapper.java.additional.8=-DuseRMISubnetFilter (line 69).
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6

Run $INSTALL_HOME/bin/vmvcs.bat install to install the cluster service as a Windows service.

7

Run $INSTALL_HOME/bin/vmvcs.bat start to start the cluster service.

What to do next
To uninstall the VSA cluster service from a Windows machine, use the Windows Add or Remove Programs
option.

Install VSA Cluster Service on Linux
Install the VSA cluster service separately on a Linux machine.
Prerequisites
Obtain the root privileges before starting the installation procedure. Run the installation script as a root user.
Procedure
1

Download and unzip the VMware-VSAClusterService-5.1.0.0-build#-linux.zip file into a $TEMP
temporary location.

2

Install the VSA cluster service by running the sudo $TEMP/setup/install.sh command.
The command uses default installation options. It creates a new vmwarevcsadmin user and installs the
VSA cluster service into the home directory of that user.

3

Modify the firewall rules to allow incoming TCP/IP connections on port range 4330-4339.
Perform this step only if during the installation process a warning message requested you to modify the
firewall rules. If the message did not appear, the installer was able to modify the firewall rules and no
further firewall changes are required.

After installation completes, the cluster service starts automatically.
What to do next
Delete the $TEMP directory after the installation completes successfully.

Command-Line Options to Install VSA Cluster Service
You can use various command-line options with the install.sh command when you install the VSA cluster
service on a Linux machine.
Table 2‑7. Command-Line Options for install.sh
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Option

Description

-h | --help

Print this help.

-p password | --pass password

Password for the vmwarevcsadmin account. If you do not
specify this parameter, the password is not set for the
account. As a result, login to this account will be disabled.
Set the password if login is necessary. VMware
recommends that you disable login to account
vmwarevcsadmin. The parameter is optional.

-d install-dir | --dir install-dir

Path to a directory where the VSA cluster service is
installed. The default value is VSAClusterService-5.1
inside the home directory of user vmwarevcsadmin. The
parameter is optional. vmwarevcsadmin.

-v | --verbose

Print verbose information.

-D | --debug

Print all commands and their arguments as they are
executed (set -x).
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Example: Use of Command-Line Options with Install Script
n

setup/install.sh. Installs the VSA cluster service to the vmwarevcsadmin user home directory. The user

will be created if required.

n

setup/install.sh -d /work/vcs-5.1 -p secret. Installs the VSA cluster service to the
directory /work/vcs-5.1 and changes the user account password to secret.

Uninstall VSA Cluster Service from Linux
You can uninstall the VSA cluster service from a Linux machine.
The procedure assumes that the VSA cluster service was installed in an $INSTALL_HOME directory. The default
$INSTALL_HOME directory is ~vmwarevcsadmin/VSAClusterService-5.1. If you used the -d command-line
option to set another directory during installation, use the directory you specified.
Prerequisites
Obtain the root privileges before starting the procedure. Run the uninstall script as a root user.
Procedure
1

Run $INSTALL_HOME/setup/uninstall.sh to uninstall the VSA Cluster Service.

2

Confirm that you want to delete the $INSTALL_HOME directory, vmwarevcsadmin user, and the user home
directory.

3

(Optional) If you manually changed the firewall rules when installing the VSA cluster service, reverse
the changes.

Command-Line Options to Uninstall VSA Cluster Service
You can use various command-line options with the uninstall.sh command when you uninstall the VSA
cluster service from a Linux machine.
Table 2‑8. Command-Line Options for uninstall.sh
Option

Description

-h | --help

Print this help.

-k | --keepuser

If this option is specified, the uninstall script does not
remove the user account. By default, the user account is
removed.

-s | --silent

If this option is specified, the uninstall script does not ask
you to confirm the deletion of the directories and the user
account. This option is useful for scripted uninstall that
does not require user interaction.

-v | --verbose

Print verbose information.

-D | --debug

Print all commands and their arguments as they are
executed (set -x).

Example: Use of Command-Line Options with Uninstall Script
n

$INSTALL_HOME/setup/uninstall.sh. Uninstalls the VSA cluster service. Prompts you to confirm the
directory and user account deletion.

n

$INSTALL_HOME/setup/uninstall.sh -s –k. Uninstalls the VSA cluster service. Does not prompt you to
confirm the directory deletion and keeps the user account intact.
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Control VSA Cluster Service
After you install the VSA cluster service, use the vmvcs script to send the service control commands such as
stop, start, query the status, and so on.
Procedure
u

Run one of the following commands:
n

On Windows, $INSTALL_HOME/bin/vmvcs.bat command.

n

On Linux, $INSTALL_HOME/bin/vmvcs command

Table 2‑9. Commands Supported by vmvcs Script
Command

Description

Platform

start

Starts the cluster service as a system service.

Windows and Linux

stop

Stops the cluster service.

Windows and Linux

restart

Restarts the cluster service.

Windows and Linux

console

Starts the cluster service in a console mode as a
foreground process. Use CTRL+C to stop it.

Windows and Linux

status

Provides status of the cluster service process
(running/not running).

Windows and Linux

cleanup

Cleans the state of a cluster member. Run this command
if you want to use this member as a part of another
cluster or want to rebuild the cluster.

Windows and Linux

condrestart

Restarts the cluster service but only if it is currently
running.

Linux only

dump

Dumps Java thread stack traces. Useful for debugging to
understand the Java process thread states.

Linux only

Enable VSA Access for the vSphere Web Client
You use the vSphere Web Client to connect to a vCenter Server system in a web browser. To be able to
manage VSA clusters, you need to activate VSA access for the vSphere Web Client.
Prerequisites
n

Install vSphere Web Client. For information, see the vSphere Installation and Setup documentation.

n

Install the VSA Manager Appliance and register it with vCenter Server.

Procedure
1

On the computer where the vSphere Web Client is installed, locate the webclient.properties file. If the
file is not present, create it.
The location of this file depends on the operating system on which the vSphere Web Client is installed.

2
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Operating System

File path

Windows 2003

%ALLUSERSPROFILE%Application Data\VMware\vSphere Web Client

Windows 2008

%ALLUSERSPROFILE%\VMware\vSphere Web Client

Edit the file to include the following line: allowHttp=true
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3

Restart the vSphere Web Client service.
On Windows operating systems, restart the VMware vSphere Web Client service.

4

Open a web browser and enter the URL for the vSphere Web Client:
https://client-hostname:port/vsphere-client.
The default port is 9443, but this can be changed during vSphere Web Client installation.
The vSphere Web Client detects that VSA is registered with vCenter Server and retrieves necessary
configuration information.

5

Navigate to the VSA Manager tab.
a

Select a datacenter that has two or more ESXi hosts.

b

Click the Classic Solutions tab.

Enable the VSA Manager Plug-In in the vSphere Client
You must enable the VSA Manager plug-in if the VSA Manager tab does not appear when you select a
datacenter object.
Prerequisites
The VSA Manager tab does not appear when you select a datacenter object.
Procedure
1

Select Plug-ins > Manage Plug-ins.

2

In the Plug-In Manager window, right-click the VSA Manager plug-in and select Enable.

The VSA Manager tab appears.

Upgrade vSphere Storage Appliance Environment (5.1 and earlier)
You can upgrade vSphere Storage Appliance and VSA cluster components to version 5.1.
Upgrading by following these steps upgrades the VSA cluster as well as the vSphere Storage Appliances A
successful upgrade ensures that all vSphere Storage Appliances are upgraded to version 5.1. Mixed-version
clusters cannot be managed by VSA Manager 5.1.
The single vSphere Storage Appliance upgrade procedure upgrades VSA Manager, the VSA cluster service,
and the VSA cluster. When you upgrade vSphere Storage Appliance that is installed on the vCenter Server
computer, you must first upgrade vCenter Server to a compatible version. You also upgrade ESXi hosts that
are the VSA cluster members. For information on upgrading vCenter Server and ESXi, see the vSphere
Installation and Setup documentation.
The following upgrade procedure is a full upgrade of vCenter Server, VSA and ESX. To upgrade only VSA
but not upgrade vCenter Server or ESX, follow step 2 of the upgrade procedure only.
Prerequisites
Ensure that you have a complete backup of all virtual machines that run on the VSA cluster, on media other
than the VSA Cluster components. Verify that the VSA cluster is up and functioning properly.
Procedure
1

If vCenter Server is not already running version 5.1, upgrade vCenter Server to version 5.1.

2

If the vSphere Storage Appliance is not already running version 5.1, upgrade it to version 5.1.
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3

Upgrade VSA Manager to version 5.1.
a

On the vCenter Server machine, start the VMware-vsamanager-en-version_number-build_number.exe
file.

b

Follow the prompts to perform the upgrade.

4

Put the VSA cluster into cluster maintenance mode.

5

Upgrade ESXi hosts to version 5.1.

6

Take the VSA cluster out of maintenance mode.

What to do next
The following is the recommended order for upgrade:
Upgrade vCenter Server from version 5.0 to 5.1.
Upgrade the vSphere Storage Appliance from version 1.0 to 5.1.
Enter cluster maintenance mode.
Upgrade the ESXi hosts from version 5.0 to 5.1.
Exit cluster maintenance mode.
If the VSA Manager tab is disabled after you upgrade vCenter Server, restart VMware VirtualCenter
Management Webservices. For information, see “VSA Manager Tab Does Not Appear,” on page 74.
Enable memory overcommitment on all virtual machines that run on the VSA cluster. For information, see
“VSA Cluster and Memory Overcommitment,” on page 51.
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3

After you install and configure the components of the VSA cluster, you can create a VSA cluster with the
VSA Installer or VSA Automated Installer.
This chapter includes the following topics:
n

“Manual Creation of the VSA Cluster,” on page 41

n

“Automated Creation of a VSA Cluster,” on page 45

n

“Verify VSA Datastores in the vSphere Client,” on page 48

n

“Verify VSA Datastores in the vSphere Web Client,” on page 48

n

“Removing VSA Cluster from vCenter Server,” on page 49

Manual Creation of the VSA Cluster
You can use the VSA Installer wizard to create the VSA cluster manually.
The VSA Installer wizard provides a graphical workflow to install the VSA cluster.
After you complete the steps in the wizard, the VSA Installer performs a set of tasks that create the VSA
cluster.
1

For newly installed ESXi, the installer configures the network of each ESXi host.
The installer creates a front-end and a back-end virtual switch on each ESXi instance to support the
front-end and back-end networks of the cluster. The installer selects two uplink ports for each virtual
switch from the four available NIC ports. As a result, each virtual switch has one primary and one
redundant uplink.
If you use existing hosts that have preconfigured vSwitches, the installer audits the vSwitches.

2

Deploys a vSphere Storage Appliance on each ESXi host.

3

Configures each vSphere Storage Appliance to export one half of the ESXi VMFS storage space as a VSA
datastore, and the other half as a replica of another VSA datastore.

4

n

VSA 0 exports VSA datastore 0 and maintains a replica of VSA datastore 2.

n

VSA 1 exports VSA datastore 1 and maintains a replica of VSA datastore 0.

n

VSA 2 exports VSA datastore 2 and maintains a replica of VSA datastore 1.

Configures the network interfaces on each vSphere Storage Appliance to establish the front-end and
back-end networks of the VSA cluster.

The VSA cluster members form the VSA cluster by establishing a process of electing a cluster leader. The
cluster leader is the VSA cluster member that communicates with VSA Manager to report the status of the
VSA cluster.
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Create a VSA Cluster
You use the VSA Installer to deploy vSphere Storage Appliance and create a VSA cluster. A VSA cluster
enables shared datastores that are connected to all hosts in the datacenter. The VSA Installer enables and
configures vMotion and High Availability on the created VSA cluster.
Note When you use the VSA Installer, it deletes the existing data on the local hard disks of each host and
changes configuration of the hosts to support vMotion and High Availability. Hosts might reboot during the
installation process.
Prerequisites
n

Assign a static IP address to the vCenter Server system.

n

Clear all vCenter Server alarms for the hosts that you plan to add to the cluster.

n

If ESXi hosts you use for the cluster have virtual machines running on their local datastores, make sure
that these virtual machines do not have reserved memory. Disable memory reservations by deselecting
the Reserve all guest memory (All locked) check box. For information, see “Change Memory
Reservations on a Virtual Machine in the vSphere Web Client,” on page 52.

n

Ensure that you have the right number of static IP addresses available for you VSA cluster. For more
information about IP address requirements, see “VSA Cluster Requirements,” on page 20.

Procedure
1

Start the VSA Installer wizard.
n

In vSphere Client, select a datacenter that has two or more ESXi hosts, and click the VSA Manager
tab.

n

In the vSphere Web Client, select a datacenter that has two or more ESXi hosts, and click Manage >
VSA Manager.

The VSA Installer wizard appears in the tab.
2

Review the vSphere features that the VSA cluster enables and click Next.

3

On the Datacenter page, select a datacenter for the VSA cluster and click Next.

4

If your environment has hosts of different version, select the version on the Hosts page.
Only hosts of the same version are displayed.

5

Select two or three ESXi hosts and click Next.
The wizard categorizes the hosts by CPU family and subnet. You can include only hosts that have CPUs
from the same CPU family and are on the same subnet.
If you select hosts from different CPU families or with different hardware configurations, the wizard
informs you that the hosts cannot join the same VSA cluster.

42

VMware, Inc.

Chapter 3 Creating a VSA Cluster

6

On the Configure Network page, provide the IP addresses and configuration for the VSA cluster
network, and click Next.
Table 3‑1. VSA Cluster Network Configuration Values
Option

Action

VSA Cluster IP Address

Assign a static IP address for the VSA cluster. The VSA cluster IP
address is assigned to the VSA cluster member that is the leader of
the cluster. Do not use an IP address from the 192.168.x.x private
subnet.

VSA Cluster Service IP Address

Assign a static IP address for the VSA cluster service. The VSA
cluster service must already be installed and running at the IP
address you provide. Do not use an IP address from the 192.168.x.x
private subnet. In a simple two member configuration, you can use
the IP address of vCenter Server.

Network of ESXi Host 1
Management IP Address

Assign a static IP address for the management network of the VSA
cluster member. Do not use an IP address from the 192.168.x.x
private subnet.

Datastore IP Address

Assign a static IP address for the NFS volume that is exported as a
VSA datastore. Do not use an IP address from the 192.168.x.x
private subnet.

vSphere Feature IP Address

This is the IP address used by vMotion.
Select the Use DHCP check box to assign an IP address to the
ESXi feature network.
n Deselect the Use DHCP check box and assign a static IP
address to the ESXi feature network.
n

Subnet Mask

The subnet mask for the ESXi host IP address. The wizard detects
the subnet mask. You cannot change it.

Gateway

The gateway in the subnet of the ESXi host IP address. The wizard
detects the gateway IP address and you cannot change it.

VLAN ID

Assign a VLAN ID for the management network.

Back-end IP Address

Assign a static IP address to the back-end network of the VSA
cluster member.
Note You cannot assign a back-end static IP address that is in a
subnet different from 192.168.x.x.

Back-end Subnet Mask

The subnet mask for the back-end network. The wizard adds this
value for the back-end private subnet and you cannot change it.

Back-end VLAN ID

Assign a VLAN ID to the back-end network.

Network of ESXi Host 2
Management IP Address

Assign a static IP address for the management network of the VSA
cluster member. Do not use an IP address from the 192.168.x.x
private subnet.

Datastore IP Address

Assign a static IP address for the NFS volume that is exported as a
VSA datastore. Do not use an IP address from the 192.168.x.x
private subnet.

vSphere Feature IP Address

n
n
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Select the Use DHCP check box to assign an IP address to the
ESXi feature network.
Deselect the Use DHCP check box and assign a static IP
address to the ESXi feature network.

Subnet Mask

The subnet mask for the ESXi host IP address. The wizard detects
the subnet mask. You cannot change it.

Gateway

The gateway in the subnet of the ESXi host IP address. The wizard
detects the gateway IP address and you cannot change it.
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Table 3‑1. VSA Cluster Network Configuration Values (Continued)
Option

Action

VLAN ID

Assign a VLAN ID for the management network.

Back-end IP Address

Assign a static IP address to the back-end network of the VSA
cluster member.
Note You cannot assign a back-end static IP address that is in a
subnet different from 192.168.x.x.

Back-end Subnet Mask

The subnet mask for the back-end network. The wizard adds this
value for the back-end private subnet and you cannot change it.

Back-end VLAN ID

Assign a VLAN ID to the back-end network.

Network of ESXi Host 3
Management IP Address

Assign a static IP address for the management network of the VSA
cluster member. Do not use an IP address from the 192.168.x.x
private subnet.

Datastore IP Address

Assign a static IP address for the NFS volume that is exported as a
VSA datastore. Do not use an IP address from the 192.168.x.x
private subnet.

vSphere Feature IP Address

n
n

7

Select the Use DHCP check box to assign an IP address to the
ESXi feature network.
Deselect the Use DHCP check box and assign a static IP
address to the ESXi feature network.

Subnet Mask

The subnet mask for the ESXi host IP address. The wizard detects
the subnet mask. You cannot change it.

Gateway

The gateway in the subnet of the ESXi host IP address. The wizard
detects the gateway IP address and you cannot change it.

VLAN ID

Assign a VLAN ID for the management network.

Back-end IP Address

Assign a static IP address to the back-end network of the VSA
cluster member.
Note You cannot assign a back-end static IP address that is in a
subnet different from 192.168.x.x.

Back-end Subnet Mask

The subnet mask for the back-end network. The wizard adds this
value for the back-end private subnet and you cannot change it.

Back-end VLAN ID

Assign a VLAN ID to the back-end network.

On the Select Storage page, specify the amount of available storage capacity to be used for the VSA
cluster.
The VSA Installer calculates the maximum allowable value based on the currently available space on
the hosts you selected. You might need to reduce that value if, for example, you plan to share storage
with the vCenter Server virtual machine that will run on the host's local datastore.

8

9
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Select when to format the disks on the Format Disks page.
Option

Description

Format disks on first access

Disks are formatted after installation on first read or write. Takes less time
for installation.

Format disks immediately

Disks are formatted during the installation with zeroes. This requires
additional time during the installation process, but result in improved disk
performance until all disk blocks are written to. After that, the difference in
performance between the two choices is unnoticeable.

On the Verify Configuration page, review the configuration of the VSA cluster and confirm that you
accept the VSA security policy.
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10

Click Install.
The Ready to Install page provides information about the ESXi hosts and the network configuration of
each VSA cluster member.

11

In the Start Installation window, click Yes to confirm the creation of the VSA cluster.
The Installing Features page appears and shows the progress of the tasks that are required to create a
VSA cluster.
Depending on the number of hosts that you selected, the VSA Installer wizard mounts two or three
shared datastores on each ESXi host in the datacenter.

12

After the VSA Installer finishes creating the VSA cluster, click Close.
The VSA Manager tab shows information about the VSA datastores, VSA cluster members, and the
configuration of the VSA cluster network.

The VSA Installer wizard closes and the VSA Manager tab shows information about each datastore, VSA
cluster member, and allows you to troubleshoot issues that might arise.
What to do next
Click the Datastores view and verify that all shared datastores have the same capacity and that their status
is Online. If the columns shows correct data, you can start creating virtual machines and storing their files
on the shared datastores.
Change the default password.
Perform a network redundancy check by disconnecting one of the back-end ethernet ports. This check
ensures that both back-end ethernet ports are properly configured.

Automated Creation of a VSA Cluster
The VSA automated installer includes vSphere Storage Appliance, VSA Manager, and an installation script
that installs the components and creates a VSA cluster.
Note The VSA 5.1 automated installer does not include vCenter Server. Install vCenter Server and the
vSphere Client before you run the VSA installer.
When you run the VSA automated installer, the following takes place:
1

2
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The VSA automated installer scans the subnet for available IP addresses of the ESXi hosts and performs
silent installation of the following VSA cluster components:
n

VSA Manager

n

VSA cluster service (installed, but used only if two ESXi hosts are available in the subnet)

After all components are installed, the installer performs the tasks to create a VSA cluster.
a

Creates a datacenter and adds the ESXi hosts to it.

b

Updates the network configuration of the ESXi hosts.

c

Deploys the vSphere Storage Appliance onto the ESXi hosts.

d

Starts the VSA cluster service if only two ESXi hosts are present.

e

Powers on each instance of vSphere Storage Appliance and creates the VSA cluster.

f

Mounts the VSA datastores to each ESXi host in the datacenter.
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VSA Automated Installer Requirements
Before you run the VSA Automated Installer, verify that your environment meets specific requirements.
n

A physical or virtual Windows system that runs vCenter Server. The system must meet additional
requirements for the VSA installation. See “VSA Manager System and Software Requirements,” on
page 21.

n

Two or three physical servers that have ESXi installed and whose hard disks are configured in a RAID
volume. You can use RAID5, RAID6, or RAID10 configuration. For information about ESXi hardware
requirements, see “VSA Cluster Requirements,” on page 20.

Note The ESXi hosts and the vCenter Server system are the only running machines in the subnet.

Create a VSA Cluster with the VSA Automated Installer
To perform automated installation of the VSA cluster, you can use the automated installer script and enter
the required parameters.
Prerequisites
n

Verify that your environment meets the requirements to perform automated installation as described in
“VSA Automated Installer Requirements,” on page 46.

n

Clean the %temp% folder to free up space.

Procedure
1

On the Windows Server system that runs vCenter Server, run the installation command from the
automated installer package: install.exe.
Make sure to run the installation command from the directory where install.exe is located. Otherwise,
the installation might fail.

2

Restart the vSphere Client.

The VSA automated installer script installs all components and creates a VSA cluster.
What to do next
After the VSA Automated Installer completes the installation process, you must establish a connection
between the VSA Manager and a newly created VSA cluster. To do this, either manually restart the VMware
Virtual Center Management Webservices, or use the vSphere Client or the vSphere Web Client to access the
VSA Manager tab.

VSA Automated Installer Options
The VSA Automated Installer accepts a set of arguments and values that you can use to customize the VSA
cluster installation.
The following table shows the options that you can use to run the VSA Automated Installer.
Table 3‑2. install.exe Arguments
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Required or
Optional

Parameters

Default Value

Description

-p, --esxPass <value>

No default value.

The root password of each ESXi host.
The root password must be the same for
all ESXi hosts.

Required

-u, --esxUser <value>

No default value.

The root account. Use root.

Required
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Table 3‑2. install.exe Arguments (Continued)
Parameters

Default Value

Description

Required or
Optional

-dc <value>

No default value.

Datacenter to be used.

Required

-cn <value>
or

No default value.

Netmask of the cluster network. If you
use vCenter Server network, you can use
the vc parameter instead.

Required

-gw <value>

No default value.

Gateway of the cluster network. If you
use vCenter Server network, you can use
thevc parameter instead.

Required

-cs, -vmwareClusterServiceIP
<value>

No default value

IP address of the VSA cluster server. If
you use the cluster service installed with
VSA Manager on vCenter Server, the IP
address must be same as the IP of
vCenter Server.

Required for a
two member
cluster
configuration

-ei, --esxIPs <value>

No default value.

The IP addresses of the two or three
hosts to use for the VSA cluster
For example:
-ei 10.20.118.11 10.20.118.12
10.20.118.13

Optional

-si, --startIP <value>

No default value.

The first IP in the range used by the VSA
cluster.

Optional

-fv, --frontendVlanId
<value>

0

The VLAN ID for the front-end network.

Optional

-bs, --backendStartIP
<value>

192.168.0.1

The start IP for the back-end network.
The default value is 192.168.0.1. The
back-end IP addresses must be in the
192.168.x.x private subnet.

Optional

-bn, --backendNetmask
<value>

255.255.255.0

The netmask for the back-end network.

Optional

-bv, --backendVlanId
<value>

0

The VLAN ID for the back-end network.

Optional

-vn, --vmotionNetmask
<value>

255.255.255.0

The netmask for the ESXi feature
network.

Optional

-vs, --vmotionStartIP
<value>

DHCP

The start IP for the ESXi feature network.

Optional

-vv, --vmotionVlanId
<value>

The same as the front-end
VLAN ID.

The VLAN ID for the ESXi feature
network.

Optional

-po, --httpsPort <value>

443

HTTPS port of vCenter Server.

Optional

-ez, --eagerZero <value>

false

Determines whether to format the disks
during installation or on first read or
write operation to the disks.

Optional

-cn vc
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false

Formats the disks on
first read or write
operation after the
installation process is
completed.

true

Formats the disks
during the installation
process.
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Example: Example Command Using Options
The following example shows how this command can be used. The actual command is all on one line. It has
been formatted for ease of understanding.
install.exe -dc MyDC
-cs 10.10.10.101
-si 10.10.10.200
-u root
-p secret
-ei 10.10.10.10 10.10.10.20
-vs 10.10.10.150
-gw 10.10.10.254
-cn 255.255.255.0

Verify VSA Datastores in the vSphere Client
After you create the VSA cluster, verify that the correct number of VSA datastores appears in the vSphere
Client.
Procedure
1

In the vSphere Client, select View > Inventory > Datastores and Datastore Clusters.
The number of VSA datastores must match the number of ESXi hosts that you added to the VSA cluster.

2

Select each datastore and click the Summary tab.

3

Verify that all datastores have the same total, free, and used capacity in the Capacity panel.

4

Select each datastore and click the Hosts tab.

5

In the Datastore column verify that the status of each datastore is Mounted for each ESXi host in the
datacenter.
The Mounted status shows that each ESXi host has access to and can read and write on the matching
datastore.

What to do next
You can start deploying virtual machines on the VSA datastores.

Verify VSA Datastores in the vSphere Web Client
After you create the VSA cluster, verify that the correct number of VSA datastores appears in the vSphere
Web Client.
Procedure
1

From the vSphere Web Client Home, click vCenter.

2

Under Inventory Lists, click the Datastores category.
The number of VSA datastores must match the number of ESXi hosts that you added to the VSA cluster.
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3

Select each datastore and click Manage > Settings > General to view datastore properties.

4

Verify that all datastores have the same total, free, and used capacity in the Capacity panel.

5

Select each datastore and click Manage > Settings > Connectivity and Multipathing.
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6

Verify that the status of each datastore is Mounted for each ESXi host in the datacenter.
The Mounted status shows that each ESXi host has access to the matching datastore and can read and
write on it.

What to do next
You can start deploying virtual machines on the VSA datastores.

Removing VSA Cluster from vCenter Server
Several options exist that allow you to remove a VSA cluster from a particular vCenter Server.
Simply removing the VSA HA cluster or the ESXi hosts from vCenter Server does not guarantee that
vCenter Server stops managing the VSA cluster. To properly remove the VSA HA cluster from
vCenter Server, use one of the following options:
n

If you no longer need the VSA cluster, run the cleanup.bat script to delete the cluster from
vCenter Server. See “Delete a VSA Cluster,” on page 49.

n

If you want the cluster to be managed by a different vCenter Server system, follow these guidelines:
n

Move the cluster by changing the IP addresses of the cluster members. You can then restore the
cluster on vCenter Server of your choice. See “Moving a VSA Cluster,” on page 62.

n

Stop VMware Virtual Center Management Webservices, delete the datacenter where the VSA
cluster resides, and restart VMware Virtual Center Management Webservices. Then recover the
cluster on a new vCenter Server. See “Recover an Existing VSA Cluster,” on page 76.

Delete a VSA Cluster
VSA Manager provides a cleanup script that you use to delete a VSA cluster if you no longer use it or to
clean up the ESXi hosts configuration if you failed to create a VSA cluster and want to make another
attempt.
You cannot delete the VSA cluster by uninstalling VSA Manager. To delete the VSA cluster, you must use
the cleanup.bat script that is installed by VSA Manager.
Procedure
1

In Windows Server 2003 or 2008, start the Command Prompt.

2

In the Command Prompt, change directory to the directory of the cleanup.bat script.
cd C:\Program Files\VMware\Infrastructure\tomcat\webapps\VSAManager\WEB-INF\test\tool\

3

Run the cleanup.bat script and provide Administrator credentials for vCenter Server.
cleanup.bat user password datacenter_name

For datacenter_name, type the name of a datacenter that accommodates the VSA cluster you want to
remove. If you do not provide the name, the script removes all available clusters.
The cleanup.bat script unmounts and deletes the VSA datastores, stops and deletes the VSA virtual
machines, and reverts the ESXi hosts to their default configuration. The script removes additional
virtual switches and uplinks and preserves only the default port groups for the default virtual switch.
After the process finishes, the ESXi hosts might appear with an alert icon in the vCenter Server
inventory. This is because the script deletes the redundant uplinks for the default virtual switch. The
VSA Manager tab shows a message that the VSA cluster is now unavailable.
4
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5

Refresh the VSA Manager tab by restarting the vSphere Web Client, and VMware Virtual Center
Management Webservices.
a

Quit the client.

b

In the Command Prompt, type net stop vctomcat and press Enter to stop VMware Virtual Center
Management Webservices.
VMware Virtual Center Management Webservices stops.

c

In the Command Prompt, type net start vctomcat and press Enter to restart VMware Virtual
Center Management Webservices.
The VMware Virtual Center Management Webservices starts.

d

Start the client and navigate to the VSA Manager tab.
The VSA Manager tab shows the VSA Installer wizard.

What to do next
You can now create a new VSA cluster with the same ESXi hosts.
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4

You can perform maintenance operations on the VSA cluster, such as placing the entire cluster or just a
single VSA cluster member in the maintenance mode, replacing a VSA cluster member that is offline, and
changing the VSA cluster IP address. You should also prevent memory overcommitment in the VSA cluster
if it includes ESXi version 5.0 hosts.
This chapter includes the following topics:
n

“VSA Cluster and Memory Overcommitment,” on page 51

n

“Using Multiple VSA Clusters,” on page 54

n

“Perform Maintenance Tasks on the Entire VSA Cluster,” on page 54

n

“Perform Maintenance Tasks on a VSA Cluster Member,” on page 55

n

“Replace a VSA Cluster Member,” on page 56

n

“Change the VSA Cluster IP Address,” on page 57

n

“Change the VSA Cluster Password,” on page 57

n

“Adding Storage Capacity to VSA Clusters,” on page 58

n

“Moving a VSA Cluster,” on page 62

n

“Reconfigure the VSA Cluster Network,” on page 65

n

“Indicate Changes to Virtual Machine Configuration,” on page 68

VSA Cluster and Memory Overcommitment
Whether a VSA cluster supports memory overcommitment for virtual machines that run on VSA hosts,
depends on the version of ESXi you use.
If all cluster members run ESXi version 5.1, the VSA cluster supports memory overcommitment.
However, the VSA cluster that includes ESXi version 5.0 hosts does not support memory overcommitment.
In this type of cluster, if a virtual machine becomes overcommitted, it starts to swap to its per-virtualmachine swapfile. VMX swapping is enabled by default and swapping to VSA datastores can make the
cluster unstable, and as a result, virtual machines might begin powering off.
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To prevent virtual machine downtime, do not overcommit memory in the VSA cluster that uses ESXi 5.0
hosts. For each virtual machine in the VSA cluster, reserve the same amount of memory that is allocated to
that virtual machine and disable the machine from swapping to the VSA datastores. Such a configuration
ensures that all virtual machines running on an ESXi host in the VSA cluster do not use more memory than
that available on the host, and do not attempt to perform VMX swapping.
Important After you upgrade to vSphere 5.1 and VSA 5.1, optionally reverse these changes to enable
memory overcommitment for virtual machines.
For a VSA cluster that has HA enabled, the cluster reserves additional host memory to support the restart of
virtual machines from a failed peer host. In a 2-member VSA cluster, HA reserves 50 percent of the reserved
memory of each host for the restart of a failed-over virtual machine. Similarly, in a 3-member VSA cluster,
HA reserves 33 percent of the reserved memory of each host for the restart of a failed-over virtual machine.
If you attempt to power on a virtual machine that exceeds the reserved memory threshold, the operation
fails. Due to the memory threshold of an ESXi host, it is possible that not all virtual machines can be
restarted on a running host in the event of a host failure.

Set Memory Reservation on a Virtual Machine in the vSphere Client
If your cluster includes ESXi 5.0 hosts, you must avoid memory overcommitment. To prevent memory
overcommitment in the VSA cluster, reserve all of the memory allocated to each virtual machine that runs in
the VSA cluster.
After you upgrade to vSphere 5.1 and VSA 5.1, make sure to reverse these changes to enable memory
overcommitment for virtual machines.
Prerequisites
Power off the virtual machine before configuring the memory settings.
Procedure
1

In the vSphere Client, right-click a virtual machine from the inventory and select Edit Settings.

2

In the Virtual Machine Properties window, select the Resources tab and select Memory.

3

In the Resource Allocation panel, set appropriate memory reservations.

4

n

To avoid memory overcommitment for VSA 5.0, select the Reserve all guest memory (All locked)
check box.

n

To enable memory overcommitment for VSA 5.1, deselect the Reserve all guest memory (All
locked) check box.

Click OK.

What to do next
Repeat the same steps for all virtual machines that run in the VSA cluster.

Change Memory Reservations on a Virtual Machine in the vSphere Web Client
If your cluster includes ESXi 5.0 hosts, you must avoid memory overcommitment. To prevent memory
overcommitment in the VSA cluster, reserve all of the memory allocated to each virtual machine that runs in
the VSA cluster.
After you upgrade to vSphere 5.1 and VSA 5.1, make sure to reverse these changes to allow memory
overcommitment for virtual machines.
Prerequisites
Power off the virtual machine before configuring the memory settings.
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Procedure
1

In the vSphere Web Client, right-click a virtual machine and select Edit Settings.

2

Click the Virtual Hardware tab and click Memory to expand the menu.

3

In the Reservations field, set appropriate memory reservations.

4

n

To avoid memory overcommitment for VSA 5.0, enable memory reservation by selecting the
Reserve all guest memory (All locked) check box.

n

To allow memory overcommitment for VSA 5.1, disable memory reservation by deselecting the
Reserve all guest memory (All locked) check box.

Click OK.

What to do next
Repeat the same steps for all virtual machines that run in the VSA cluster.

Set VMX Swapping on a Virtual Machine in the vSphere Client
If your cluster includes ESXi 5.0 hosts, prevent virtual machines from VMX swapping to the VSA datastores
by disabling VMX swapping on each virtual machine that runs in the VSA cluster.
After you upgrade to vSphere 5.1 and VSA 5.1, make sure to reverse these changes to enable VMX swapping
for virtual machines.
Prerequisites
Power off the virtual machine before you change its settings.
Procedure
1

In the vSphere Client, right-click a virtual machine from the inventory.

2

Select the Options tab, and under Advanced, select General.

3

Click Configuration Parameters.
The Configuration Parameters window appears.

4

Depending on the VSA version, perform one of the following actions to disable or enable the virtual
machine swapping to the VSA datastores.
Option

Action

Disable VMX swapping (VSA 5.0)

a
b

Enable VMX swapping (VSA 5.1)

5

Click Add Row.
Type sched.swap.vmxSwapEnabled for the name and false for the
value.

Change the value for sched.swap.vmxSwapEnabled to true.

In the Virtual Machine Properties window, click OK to confirm the changes.

What to do next
Repeat the steps for all virtual machines in the VSA cluster.

Set VMX Swapping on a Virtual Machine in the vSphere Web Client
If your cluster includes ESXi 5.0 hosts, prevent virtual machines from VMX swapping to the VSA datastores
by disabling VMX swapping on each virtual machine that runs in the VSA cluster.
After you upgrade to vSphere 5.1 and VSA 5.1, make sure to reverse these changes to enable VMX swapping
for virtual machines.
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Prerequisites
Power off the virtual machine before you change its settings.
Procedure
1

In the vSphere Web Client, right-click a virtual machine and select Edit Settings.

2

Click the VM Options tab, and click Advanced to expand the menu.

3

In the Configuration Parameters field, click Edit Configuration.

4

Depending on the VSA version, perform one of the following actions to disable or enable the virtual
machine swapping to the VSA datastores.
Option

Action

Disable VMX swapping (VSA 5.0)

a
b

Enable VMX swapping (VSA 5.1)

5

Click Add Row.
Type sched.swap.vmxSwapEnabled for the name and false for the
value.

Change the value for sched.swap.vmxSwapEnabled to true.

Click OK.

What to do next
Repeat the steps for all virtual machines in the VSA cluster.

Using Multiple VSA Clusters
You can create multiple VSA clusters and manage them using one centrally located vCenter Server.
Because vCenter Server and VSA Manager do not need to be in the same subnet as VSA clusters, you can
have vCenter Server and VSA Manager installed in one location and use them to manage multiple VSA
clusters in different remote locations. You can create new VSA clusters or add existing clusters to
vCenter Server.
When you use multiple VSA clusters, certain considerations apply:
n

Use a single datacenter for each VSA cluster.

n

vCenter Server does not support having different versions of VSA Clusters or upgrading each cluster
individually.

n

Manage one VSA cluster at a time. To manage VSA clusters, you switch between corresponding
datacenters.

n

Any management tasks performed on a VSA cluster do not affect other clusters and datacenters.

n

VSA Manager supports concurrent management tasks on different VSA clusters. While a VSA cluster
completes a particular management operation, you can switch to a different datacenter to work with
another cluster.

Perform Maintenance Tasks on the Entire VSA Cluster
You can put the VSA cluster in maintenance mode to perform maintenance tasks on any of its components
(hosts, datastores, networking, and so on).
Prerequisites
With the exception of the VSA virtual machines, shut down the operating systems and power off all virtual
machines in the VSA cluster.
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Procedure
1

2

Access the VSA Manager tab.
n

In the vSphere Client, select the datacenter that accommodates the VSA cluster, and click VSA
Manager

n

In the vSphere Web Client, select the datacenter that accommodates the VSA cluster, and click
Manage > VSA Manager.

Click the VSA Cluster Maintenance Mode link in the upper-right corner of the tab.
A confirmation dialog box appears.

3

Click Yes in the dialog box.
The VSA cluster status is now Maintenance and the status of all datastores is now Offline.

4

Perform maintenance tasks on the hardware or on the software within the VSA cluster.

5

After you complete the maintenance, click Exit VSA Cluster Maintenance Mode.
The status of the VSA cluster and the datastores changes to Online.

Perform Maintenance Tasks on a VSA Cluster Member
You can put a VSA cluster member in maintenance mode and perform maintenance tasks on the host that
accommodates the member.
VSA cluster member host IP addresses are stored withing the VSA. Changing the IP address of a VSA
cluster member can cause connection failures.
Prerequisites
Verify that all hosts in the cluster are running and that all datastores are available.
Procedure
1

Access the VSA Manager tab.
n

In the vSphere Client, select the datacenter that accommodates the VSA cluster, and click VSA
Manager

n

In the vSphere Web Client, select the datacenter that accommodates the VSA cluster, and click
Manage > VSA Manager.

2

Select the Appliances view.

3

Right-click the VSA cluster member that you want to place in maintenance mode and select Enter
Appliance Maintenance Mode.

4

Click Yes in the confirmation dialog.
The status of the VSA cluster member changes to Maintenance mode. The datastore that is exported by
this VSA cluster member is now available through its replica that is exported by a VSA cluster member
that runs on another host. The status of the datastore changes to Degraded, which means that the
datastore is no longer highly available, because its replica is not Online.

5

Perform maintenance operations on the hardware of the host that accommodates the VSA cluster
member that is in maintenance mode.

6

After you complete the maintenance operations, exit maintenance mode.
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a

Click the Related Objects tab, and click Hosts.

b

Select the host that accommodates the VSA cluster member in maintenance mode and select Power
On from the right-click menu.
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c

In the VSA Manager Appliances view, verify that the status of the VSA cluster member is correctly
displayed as Maintenance Mode.

d

Right-click the VSA cluster member and select Exit Appliance Maintenance Mode.

Replace a VSA Cluster Member
Use the Replace VSA Cluster Member wizard to replace an ESXi host that failed or underwent storage
configuration changes.
You can use a newly installed ESXi host as a replacement. You can also use an existing host that underwent
storage reconfiguration or was repaired after a failure. The management IP of the existing ESXi host can be
reused.
Prerequisites
n

Power off and delete the VSA appliance from the ESXi host that needs to be replaced.
Caution If you do not delete the VSA appliance, it will attempt to rejoin the cluster when you later
add the host to the cluster. This might cause unpredictable consequences.

n

Power off and remove from the vCenter Inventory the ESXi host that needs to be replaced.

n

Add a replacement ESXi host to vCenter Server. Make sure that the replacement host does not have any
remaining VSA appliances.

Procedure
1

In the VSA Manager tab, click Appliances.

2

Right-click a VSA cluster member whose status is Offline and click Replace Appliance.
The Replace Appliance wizard appears.

3

On the Select Appliance page, select the vSphere Storage Appliance whose status is Offline, and click
Next.

4

On the Select Host page, select a replacement ESXi host and click Next.
VSA Manager verifies whether the available ESXi hosts meet the requirements to join a VSA cluster.

5

6

Select when to format the disks on the Format Disks page.
Option

Description

Format disks on first access

Disks are formatted after installation on first read or write. Takes less time
for installation.

Format disks immediately

Disks are formatted during the installation with zeroes. This requires
additional time during the installation process, but result in improved disk
performance until all disk blocks are written to. After that, the difference in
performance between the two choices is unnoticeable.

On the Verify Configuration page, review the configuration of the replacement vSphere Storage
Appliance, click Install, and click Yes in the confirmation dialog.
Wait for the wizard to finish replacing the failed VSA cluster member.

7

After the wizard completes the task, click Close.

The wizard deploys a vSphere Storage Appliance on the replacement ESXi host and configures the
appliance to join the VSA cluster and replace the failed VSA cluster member.
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Change the VSA Cluster IP Address
The VSA cluster IP address belongs to the VSA cluster member that is elected to be the leader of the VSA
cluster. If another member is elected as the leader, the VSA cluster IP address is assigned to the new leader
member. You can change the IP address after you install the VSA cluster.
Procedure
1

Access the VSA Manager tab.
n

In the vSphere Client, select the datacenter that accommodates the VSA cluster, and click VSA
Manager

n

In the vSphere Web Client, select the datacenter that accommodates the VSA cluster, and click
Manage > VSA Manager.

2

Click Properties in the upper-right corner.

3

Provide a new cluster management IP address in the VSA Cluster Properties dialog box.
The new IP address must be in the same subnet as the ESXi hosts that are members of the cluster.
Important You cannot change the netmask and the default gateway. This ensures that the new IP
address is in the same subnet as the cluster members.

4

Click OK.

The VSA cluster IP address is now changed.

Change the VSA Cluster Password
You can change the default VSA cluster password.
Note Make a careful note of the new default password, as that will be required by VMware support in
order to investigate issues reported on Support Requests.
Procedure
1

Access the VSA Manager tab.
n

In the vSphere Client, select the datacenter that accommodates the VSA cluster, and click VSA
Manager

n

In the vSphere Web Client, select the datacenter that accommodates the VSA cluster, and click
Manage > VSA Manager.

2

In the VSA Manager tab, click Change Password in the upper-right corner of the tab.

3

In the Change VSA Cluster Password dialog box, type the information required to change the VSA
cluster password.
Option

Action

Username

Type svaadmin.

Old Password

Type the current VSA cluster password.

New Password

Type the new VSA cluster password.

New Password Confirmation

Retype the new VSA cluster password.

The default VSA cluster password is svapass.
4
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The VSA cluster password is changed.

Adding Storage Capacity to VSA Clusters
If any unused storage capacity remains on ESXi cluster members, you can expand an existing VSA cluster
when it needs more storage space. You can also expand the VSA cluster after you increase physical storage
capacity on the cluster members.
Use one of the following methods to increase physical storage capacity on ESXi hosts:
n

Install additional physical storage disks on the ESXi host. This method allows you to use a single RAID
on your host or to create a separate RAID out of newly installed disks.

n

Replace existing storage disks with larger capacity disks on the ESXi host.

n

Change the host's hardware RAID level to increase space efficiency, for example, change RAID 10 to
RAID 5 or RAID 6.

Note VMware recommends that you upgrade storage equally on all ESXi hosts that are cluster members.
Depending on whether you add storage capacity within a single RAID, or create an independent RAID, the
workflows you use to modify overall storage capacity of your cluster differ. After you perform the tasks to
add storage to cluster members, the VSA cluster detects additional space and can be expanded.

Adding Storage Within a Single RAID
You can use a single RAID configuration when you install additional physical disks on ESXi hosts, replace
physical disks with larger disks, or convert the existing hardware RAID level to another RAID level to
increase the usable storage capacity.
This approach requires that you take a cluster member offline and reconfigure its physical storage using a
single RAID as a configuration option. You then reintroduce the cluster member into the VSA cluster. The
VSA cluster detects additional storage capacity and can be expanded.
Note When you use this approach, on disk data is destroyed. However, data is preserved on mirror
replicas if you perform all tasks for one node at a time. The data is synchronised back when you replace a
cluster member.
The workflow includes several tasks.
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1

Place the VSA cluster into maintenance mode. See “Perform Maintenance Tasks on the Entire VSA
Cluster,” on page 54.

2

Power off and remove the ESXi host to reconfigure.

3

Reconfigure host's physical storage capacity and create a single RAID. See “Reconfigure Storage on an
ESXi Host,” on page 59.

4

Reinstall ESXi on the host and add the new ESXi host to the VSA datacenter.

5

Reintroduce the host to the VSA cluster. See “Replace a VSA Cluster Member,” on page 56.

6

Expand the VSA cluster. See “Increase VSA Cluster Storage Capacity,” on page 62.

VMware, Inc.

Chapter 4 Maintaining a VSA Cluster

Adding a New RAID
When you install additional physical disks on ESXi hosts, you can create an independent RAID set with
these disks.
With this approach, you do not need to replace the cluster member. Instead, you add the new RAID as an
extent to your host's local VMFS datastore. You can then expand the VSA cluster after it detects additional
storage capacity.
Note This method preserves on disk data.
The entire workflow includes these tasks.
1

Place the VSA cluster into maintenance mode. See “Perform Maintenance Tasks on the Entire VSA
Cluster,” on page 54.

2

Power off the ESXi host to reconfigure.

3

Install new storage disks and create a new RAID set using the disks. See “Reconfigure Storage on an
ESXi Host,” on page 59.
The new RAID appears on the host as a new storage device that you can add as an extent to the host's
local VMFS datastore.

4

Increase the capacity of the host's VMFS datastore by adding the new extent. See “Increase VMFS
Datastore Capacity in the vSphere Client,” on page 60 or “Increase VMFS Datastore Capacity in the
vSphere Web Client,” on page 61.

5

Exit VSA maintenance mode.

6

Expand the VSA cluster. See “Increase VSA Cluster Storage Capacity,” on page 62.

Reconfigure Storage on an ESXi Host
Reconfigure your ESXi host to increase the usable storage capacity.
Procedure
1

Power off the ESXi host.

2

(Optional) Modify storage disks on the host.
n

Install additional physical disks.

n

Replace existing disks with larger disks.

3

Power on the host.

4

Use the hardware RAID utility to change the RAID configuration.
n

If you added physical disks, you can include all disks into a single RAID, or create a separate RAID
using only the new disks.

n

If you did not modify storage disks, you can use the RAID utility to change the hardware RAID
level. For example, you can change RAID 10 to RAID 5 to increase space efficiency.

What to do next
Depending on whether you are using all of the physical disks in a single RAID, or adding newly installed
disks as a separate RAID, your next actions vary.
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Option

Description

Single RAID

Reintroduce the host to the VSA cluster by using the Replace Appliance wizard.

Multiple RAIDs

Increase the capacity of the host's VMFS datastore by adding the new storage extent.

Increase VMFS Datastore Capacity in the vSphere Client
When you need to create virtual machines on a datastore, or when the virtual machines running on a
datastore require more space, you can dynamically increase the capacity of a VMFS datastore.
Use one of the following methods to increase a VMFS datastore:
n

Add a new extent. An extent is a partition on a storage device. You can add up to 32 extents of the same
storage type to an existing VMFS datastore. The spanned VMFS datastore can use any or all of its
extents at any time. It does not need to fill up a particular extent before using the next one.

n

Grow an extent in an existing VMFS datastore, so that it fills the available adjacent capacity. Only
extents with free space immediately after them are expandable.

Note If a shared datastore has powered on virtual machines and becomes 100% full, you can increase the
datastore's capacity only from the host with which the powered on virtual machines are registered.
Prerequisites
Required privilege: Host.Configuration.Storage Partition Configuration
Procedure
1

Log in to the vSphere Client and select a host from the Inventory panel.

2

Click the Configuration tab and click Storage.

3

From the Datastores view, select the datastore to increase and click Properties.

4

Click Increase.

5

Select a device from the list of storage devices and click Next.
Option

Description

To add a new extent

Select the device for which the Expandable column reads NO.

To expand an existing extent

Select the device for which the Expandable column reads YES

6

Review the Current Disk Layout to see the available configurations and click Next.

7

Select a configuration option from the bottom panel.
Depending on the current layout of the disk and on your previous selections, the options you see might
vary.
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Option

Description

Use free space to add new extent

Adds the free space on this disk as a new extent.

Use free space to expand existing
extent

Expands an existing extent to a required capacity.

Use free space

Deploys an extent in the remaining free space of the disk. This option is
available only when you are adding an extent.

Use all available partitions

Dedicates the entire disk to a single extent. This option is available only
when you are adding an extent and when the disk you are formatting is
not blank. The disk is reformatted, and the datastores and any data that it
contains are erased.
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8

Set the capacity for the extent.
The minimum extent size is 1.3GB. By default, the entire free space on the storage device is available.

9

Click Next.

10

Review the proposed layout and the new configuration of your datastore, and click Finish.

What to do next
After you grow an extent in a shared VMFS datastore, refresh the datastore on each host that can access this
datastore, so that the vSphere Client can display the correct datastore capacity for all hosts.

Increase VMFS Datastore Capacity in the vSphere Web Client
When you need to add virtual machines to a datastore, or when the virtual machines running on a datastore
require more space, you can dynamically increase the capacity of a VMFS datastore.
If a shared datastore has powered on virtual machines and becomes 100% full, you can increase the
datastore's capacity only from the host with which the powered on virtual machines are registered.
Procedure
1

Select the datastore to grow and click the Increase Datastore Capacity icon.

2

Select a device from the list of storage devices.
Your selection depends on whether an expandable storage device is available.
Option

Description

To expand an existing extent

Select the device for which the Expandable column reads YES. A storage
device is reported as expandable when it has free space immediately after
the extent.

To add a new extent

Select the device for which the Expandable column reads NO.

3

Review the Current Disk Layout to see the available configurations and click Next.

4

Select a configuration option from the bottom panel.
Depending on the current layout of the disk and on your previous selections, the options you see might
vary.

5

Option

Description

Use free space to add new extent

Adds the free space on this disk as a new extent.

Use free space to expand existing
extent

Expands an existing extent to a required capacity.

Use free space

Deploys an extent in the remaining free space of the disk. This option is
available only when you are adding an extent.

Use all available partitions

Dedicates the entire disk to a single extent. This option is available only
when you are adding an extent and when the disk you are formatting is
not blank. The disk is reformatted, and the datastores and any data that it
contains are erased.

Set the capacity for the extent.
The minimum extent size is 1.3GB. By default, the entire free space on the storage device is available.

6

Click Next.

7

Review the proposed layout and the new configuration of your datastore, and click Finish.
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Increase VSA Cluster Storage Capacity
After you add physical storage to your ESXi hosts, you can grow a VSA cluster to include additional space.
Perform this operation during a maintenance window while no VSA datastore I/O is occurring.
Prerequisites
Back up any valuable data that is located on a VSA cluster.
Procedure
1

Access the VSA Manager tab.
n

In the vSphere Client, select the datacenter that accommodates the VSA cluster, and click VSA
Manager

n

In the vSphere Web Client, select the datacenter that accommodates the VSA cluster, and click
Manage > VSA Manager.

2

Click the Increase Storage link in the VSA Cluster Properties panel.

3

To increase the overall VSA cluster storage capacity, specify the amount of storage you want to use and
click Next.
The maximum value is based on the space currently available on the hosts. This value does not include
space that VSA reserves for future upgrades and other needs.

4

Review the changes and click Increase.

5

Confirm that you want to increase storage capacity and click OK.

Moving a VSA Cluster
You can move a VSA cluster from one location to another.
An ability to move a cluster allows you to create and test a VSA cluster in one location, such as a central
office, and then turn off the cluster and migrate it to another location, such as a remote office. At the
destination location, vCenter Server can discover the cluster and recover it in a different network.
Note The move cluster operation does not support virtual machines other than VSA virtual machines to be
present on the ESXi hosts. If you created any virtual machines on the ESXi hosts VSA datastores, unregister
them from vCenter Server inventory before starting the move operation. These virtual machines can remain
on the local VMFS volume.
When you move a VSA cluster, you perform several tasks.
1

Power down the cluster at the original location. See “Prepare a VSA Cluster to Be Moved,” on page 62.

2

Reconfigure networking for the cluster components. See “Reconfigure VSA Cluster Components,” on
page 63.

3

Reconstruct the cluster at the destination location. See “Complete VSA Cluster Move,” on page 64.

4

Reconfigure the VSA cluster network. See “Reconfigure the VSA Cluster Network,” on page 65.

Prepare a VSA Cluster to Be Moved
When you prepare a VSA cluster for a move, you power off the cluster. This operation allows you to unplug
ESXi hosts and reconfigure their networking.
Perform this procedure at the location where the VSA cluster was installed and configured.
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Procedure
1

Access the VSA Manager tab.

2

Click the Move Cluster link in the VSA Cluster Properties panel.
The Move VSA Cluster wizard opens and displays the current networking settings of the cluster.

3

On the Configure Cluster page, enter static IP addresses to be used at the cluster's new location and
click Next.
You cannot edit the subnet mask and gateway fields. These fields are set to the values currently
configured on the ESXi hosts. You can change these parameters on the ESXi hosts after you power off
the VSA cluster.

4

Review the configuration information and click Move.

5

Confirm that you want to start the move operation.
The wizard powers off the VSA cluster to prepare it for the move.

The VSA cluster saves the new network configuration information that you entered and is ready to be
moved to a new location. Because the cluster is no longer available in the datacenter, the VSA Manager tab
displays the Welcome page.
What to do next
Complete the move by recovering the cluster on this or on a different vCenter Server.

Reconfigure VSA Cluster Components
If you are moving a VSA cluster from one environment to another, you might need to reconfigure
networking for the cluster components.
Procedure
1

Reconfigure Network Settings on a Windows System on page 63
If you moved your VSA cluster to a different environment, use this procedure to reconfigure
networking on Windows systems that host vCenter Server and the VSA cluster service.

2

Reconfigure the Network Settings of the ESXi Hosts on page 64
If you moved the ESXi hosts to a different environment, you can reconfigure the network settings of
the ESXi hosts.

Reconfigure Network Settings on a Windows System
If you moved your VSA cluster to a different environment, use this procedure to reconfigure networking on
Windows systems that host vCenter Server and the VSA cluster service.
Procedure
1

Cable and power on the system.

2

From Control Panel, open the Local Area Connection Status dialog box and click Properties.

3

Select Internet Protocol (TCP/IP) in Windows Server 2003 or Internet Protocol Version 4 (TCP/IP v4) in
Windows Server 2008 and click Properties.

4

Change the IP address, netmask, gateway, and DNS servers of the system.

5

Click OK to save your changes and close all dialog boxes.
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Reconfigure the Network Settings of the ESXi Hosts
If you moved the ESXi hosts to a different environment, you can reconfigure the network settings of the ESXi
hosts.
Procedure
1

Power on the ESXi hosts.

2

From your server management interface, open the remote console interface for each ESXi host.

3

After ESXi boots, press F2.

4

In the Authentication Required dialog, type the root account credentials for the ESXi host and press
Enter.

5

Select Configure Management Network and press Enter.

6

In the Configure Management Network section, select IP Configuration and press Enter.

7

Select Set static IP address and network configuration, type the new IP address, subnet mask, and
default gateway for the host, and press Enter.

8

In the Configure Management Network section, select VLAN (optional) and press Enter.

9

Type a new VLAN ID for the ESXi management network and press Enter.

10

In the Configure Management Network section, press Escape and select Yes in the confirmation dialog
box to confirm the changed network settings.

11

Repeat the steps for each ESXi host.

Complete VSA Cluster Move
Complete the VSA cluster move by recovering the VSA cluster at a destination location.
At the destination location, vCenter Server reconstructs the VSA cluster while using the IP addresses of VSA
cluster members to access them and add to the cluster.
Prerequisites
n

Reconfigure networking for the cluster components. For information, see “Reconfigure VSA Cluster
Components,” on page 63.

n

Verify that VSA virtual machines have not been modified. Their names and annotations remain
unchanged.

n

Verify that VSA datastores remain mounted on the ESXi hosts even though the datastores are offline.

n

If you reconfigured networking on the ESXi hosts that are VSA cluster members, make sure that all
hosts are on the same subnet.

n

Verify that all ESXi hosts in the cluster have the same root password.

n

Verify that all ESXi hosts in the cluster are powered on and are ready to be added to vCenter Server.

n

Make sure that all VSA virtual machines are powered off.

n

If you use a two node cluster, verify that the VSA cluster service is up and running.

Procedure
1

Click the VSA Manager tab for the datacenter that has no configured VSA clusters.
The VSA Installer wizard opens.

2
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On the Welcome page, select Complete Move Operation and click Next.
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3

Type the required information to recover the offline VSA cluster and click Next.
Option

Action

VSA Cluster User Name

Type svaadmin.

VSA Cluster Password

Type the VSA cluster password. The default VSA cluster password is
svapass.

Host User Name

Type root.

Host Password

Type the ESXi host password.

Cluster Type

Select the cluster type, 2 node or 3 node.

VSA Host IP Address

Type the static IP address for each VSA host.

Cluster Service IP Address (2 node
cluster only)

Type the static IP address of the VSA cluster service. The VSA cluster
service should be up and running at the specified address.

Note If the information you provide is not correct, VSA Manager cannot detect the VSA cluster and
shows an error message. If you enter a wrong password, you can reset the cluster password and retry
the recover operation.
4

Review the information and confirm that you accept the VSA security policy.

5

Click Recover, and confirm that you want to start the recovery process.
VSA Manager starts the VSA cluster recovery and shows the progress on the Recover VSA Cluster
page.

VSA Manager detects the VSA cluster members, and restores the cluster and all virtual machines configured
on the cluster. If you changed subnet mask and gateway parameters on ESXi hosts, the cluster network is set
to the new values configured on the ESXi hosts. VSA Manager verifies that all cluster members and all IPs
assigned to the VSA virtual machines are in the same subnet.
What to do next
After the recovery process finishes, click Reconfigure to open the reconfigure network wizard. See
“Reconfigure the VSA Cluster Network,” on page 65.

Reconfigure the VSA Cluster Network
Run the Reconfigure VSA Cluster Network wizard to change network settings of the VSA cluster.
The IP addresses for the VSA cluster, VSA cluster service, VSA management of each VSA virtual machine,
and each NFS volume must be in the subnet of the ESXi hosts that are part of the cluster. For the feature IP
address of the ESXi hosts, you can use IP addresses assigned by DHCP or static IP addresses in the subnet of
the ESXi hosts that are part of the cluster.
Prerequisites
n

Ensure that all non-VSA virtual machines that run on the ESXi hosts are shut down. You must not stop
the VSA virtual machines, as the Reconfigure VSA Cluster Network wizard reconfigures and restarts
them during the process.

n

Start the Reconfigure VSA Cluster Network wizard:
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n

In the VSA Manager tab, click Reconfigure Network.

n

If you moved a cluster, after the recovery process completes, click Reconfigure Network.
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Procedure
1

On the VSA Cluster Network page of the wizard, provide new IP addresses in the subnet of the ESXi
hosts and click Next.
Table 4‑1. VSA Cluster Network Configuration Values
Option

Action

VSA Cluster IP Address

Assign a static IP address for the VSA cluster. The VSA cluster IP
address is assigned to the VSA cluster member that is the leader of
the cluster. Do not use an IP address from the 192.168.x.x private
subnet.

VSA Cluster Service IP Address

Assign a static IP address for the VSA cluster service. The VSA
cluster service must already be installed and running at the IP
address you provide. Do not use an IP address from the 192.168.x.x
private subnet. In a simple two member configuration, you can use
the IP address of vCenter Server.

Network of ESXi Host 1
Management IP Address

Assign a static IP address for the management network of the VSA
cluster member. Do not use an IP address from the 192.168.x.x
private subnet.

Datastore IP Address

Assign a static IP address for the NFS volume that is exported as a
VSA datastore. Do not use an IP address from the 192.168.x.x
private subnet.

vSphere Feature IP Address

This is the IP address used by vMotion.
Select the Use DHCP check box to assign an IP address to the
ESXi feature network.
n Deselect the Use DHCP check box and assign a static IP
address to the ESXi feature network.
n

Subnet Mask

The subnet mask for the ESXi host IP address. The wizard detects
the subnet mask. You cannot change it.

Gateway

The gateway in the subnet of the ESXi host IP address. The wizard
detects the gateway IP address and you cannot change it.

VLAN ID

Assign a VLAN ID for the management network.

Back-end IP Address

Assign a static IP address to the back-end network of the VSA
cluster member.
Note You cannot assign a back-end static IP address that is in a
subnet different from 192.168.x.x.

Back-end Subnet Mask

The subnet mask for the back-end network. The wizard adds this
value for the back-end private subnet and you cannot change it.

Back-end VLAN ID

Assign a VLAN ID to the back-end network.

Network of ESXi Host 2
Management IP Address

Assign a static IP address for the management network of the VSA
cluster member. Do not use an IP address from the 192.168.x.x
private subnet.

Datastore IP Address

Assign a static IP address for the NFS volume that is exported as a
VSA datastore. Do not use an IP address from the 192.168.x.x
private subnet.

vSphere Feature IP Address

n
n

Subnet Mask
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Select the Use DHCP check box to assign an IP address to the
ESXi feature network.
Deselect the Use DHCP check box and assign a static IP
address to the ESXi feature network.

The subnet mask for the ESXi host IP address. The wizard detects
the subnet mask. You cannot change it.
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Table 4‑1. VSA Cluster Network Configuration Values (Continued)
Option

Action

Gateway

The gateway in the subnet of the ESXi host IP address. The wizard
detects the gateway IP address and you cannot change it.

VLAN ID

Assign a VLAN ID for the management network.

Back-end IP Address

Assign a static IP address to the back-end network of the VSA
cluster member.
Note You cannot assign a back-end static IP address that is in a
subnet different from 192.168.x.x.

Back-end Subnet Mask

The subnet mask for the back-end network. The wizard adds this
value for the back-end private subnet and you cannot change it.

Back-end VLAN ID

Assign a VLAN ID to the back-end network.

Network of ESXi Host 3
Management IP Address

Assign a static IP address for the management network of the VSA
cluster member. Do not use an IP address from the 192.168.x.x
private subnet.

Datastore IP Address

Assign a static IP address for the NFS volume that is exported as a
VSA datastore. Do not use an IP address from the 192.168.x.x
private subnet.

vSphere Feature IP Address

n
n

Select the Use DHCP check box to assign an IP address to the
ESXi feature network.
Deselect the Use DHCP check box and assign a static IP
address to the ESXi feature network.

Subnet Mask

The subnet mask for the ESXi host IP address. The wizard detects
the subnet mask. You cannot change it.

Gateway

The gateway in the subnet of the ESXi host IP address. The wizard
detects the gateway IP address and you cannot change it.

VLAN ID

Assign a VLAN ID for the management network.

Back-end IP Address

Assign a static IP address to the back-end network of the VSA
cluster member.
Note You cannot assign a back-end static IP address that is in a
subnet different from 192.168.x.x.

Back-end Subnet Mask

The subnet mask for the back-end network. The wizard adds this
value for the back-end private subnet and you cannot change it.

Back-end VLAN ID

Assign a VLAN ID to the back-end network.

2

On the Verify Configuration page, review the new network configuration and click Install.

3

In the confirmation dialog box, click Yes.
The Reconfigure Network page of the wizard appears with the progress of the reconfiguration task. The
Reconfigure VSA Cluster Network wizard powers off all VSA virtual machines and updates the virtual
switch configuration of the ESXi hosts. After this step, the wizard powers on the VSA virtual machines
and reconfigures their network interfaces. To assign the new IP addresses to the VSA datastores, the
wizard unregisters all virtual machines from the inventory, unmounts the VSA datastores from the ESXi
hosts, assigns new addresses to the datastores, mounts them back to each ESXi host, and then adds the
virtual machines again to the inventory. When the wizard completes the task successfully, a message
appears that says that the VSA cluster network is reconfigured. When the virtual machines are
reregistered, an information icon indicates changes to their configuration.

4
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The VSA cluster network is now reconfigured.
Note If the network reconfiguration is not successful, VSA does not restore the original network settings.
Repeat the reconfiguration procedure making sure that you provide correct networking parameters.

Indicate Changes to Virtual Machine Configuration
During the reconfiguration of the VSA cluster network, the VSA datastores change IP addresses and the
virtual machines running on them must be reregistered. You can indicate that the virtual machines were
moved after the reconfiguration process completes.
Procedure
1

In the vSphere Web Client inventory, select a virtual machine with an information icon.

2

Select the Summary tab on the right.
The Summary tab shows a virtual machine message that the virtual machine has been moved or copied.

3

From the virtual machine message options, select I moved it and click OK.
The virtual machine icon changes to the default icon for powered-on virtual machine.

4

Repeat the steps for all reregistered virtual machines in the VSA cluster.

The configuration changes to the virtual machines are now indicated and their information icons disappear.
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5

The VSA Manager tab provides information about the VSA cluster network, the VSA datastores, the VSA
cluster members, and graphical representations of the connections between all components on the VSA
cluster.
n

View Information About a VSA Cluster on page 69
You can view information about the name, status, network settings, and aggregated capacity of the
VSA cluster.

n

View Information About a VSA Datastore on page 70
You can view information about a VSA datastore, such as capacity, network settings, exported volume
and its replica.

n

View Information About VSA Cluster Member Appliances on page 71
You can view the status, capacity, network, and replicas of a VSA cluster member appliance from the
VSA Manager tab.

n

View a Graphical Map of a VSA Cluster on page 72
You can view a graphical representation of the connection between the components of the VSA cluster.

View Information About a VSA Cluster
You can view information about the name, status, network settings, and aggregated capacity of the VSA
cluster.
Procedure
u

In the VSA Manager tab, view information about the storage cluster in the Cluster Properties panel.
n

View the name and status of the cluster under VSA Cluster Status.

n

If your VSA cluster has two members, view the IP address and status of the VSA cluster service
under VSA Cluster Status.

n

View the cluster management IP address under VSA Cluster Network.
The VSA cluster IP address is assigned to the member leader of the cluster and is used to manage
communication and tasks between all VSA cluster members.

n
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View the capacity of the VSA cluster under Capacity.
Option

Description

Physical Capacity

View the total physical capacity of the hard disks that are installed on all ESXi hosts.

Storage Capacity

View the total capacity of the VSA datastores that you can use to store virtual machines
and virtual disks.
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View Information About a VSA Datastore
You can view information about a VSA datastore, such as capacity, network settings, exported volume and
its replica.
The number of VSA datastores matches the number of ESXi hosts that are in the VSA cluster.
Procedure
1

In VSA Manager tab, select the Datastores view.
Information about shared datastores appears under the View area.

2

3

View information about all datastores in the table.
Column

Description

Name

View the name of the datastore.

Status

View the status of the datastore.
n Online - the datastore and its replica are online.
n Offline - the datastore and its replica are offline.
n Maintenance - the cluster in maintenance state.
n Degraded - the replica of the datastore is offline.

Capacity

View the total capacity that each datastore has.

Free

View the available space on the datastore.

Used

View the space of the datastore that is currently in use.

Exported By

View the VSA virtual machine that manages the datastore.

Datastore Address

View the IP address of the datastore that vSphere Storage Appliance
exposes.
Each ESXi host uses this IP address to read and write data on the datastore.

Datastore Netmask

View the netmask of the subnet that the datastore uses.

Select a datastore and view information about its status, network, capacity, and replica in the Datastore
Properties section.
n

View the datastore status in the Datastore Properties section.

n

View the datastore IP address in the Datastore Network section.

n

View the free and used space of the datastore in the Capacity section.

n

View the VSA virtual machines that manage the replica of the selected datastore in the bottom-left
corner.
A shared datastore has a replica which is managed by an appliance running on another ESXi host.
The hierarchy in the bottom-left corner shows which two virtual machines manage the datastore
and its replica.

4

Browse the contents of a datastore.
a

Select View > Inventory > Datastores and Datastore Clusters.

b

Right-click a datastore and select Browse Datastore.
The Datastore Browser window shows the contents of the datastore.

5
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View Information About VSA Cluster Member Appliances
You can view the status, capacity, network, and replicas of a VSA cluster member appliance from the VSA
Manager tab.
Procedure
1

In the VSA Manager tab, click Appliances.
Information about VSA cluster member appliances appear under the View area.

2

(Optional) View information about all VSA cluster member appliances in the table.
Option

Description

Name

View the name of the selected VSA virtual machine.

Status

View the status of the selected VSA virtual machine.
Online - the VSA cluster member is online.
n Offline - the VSA cluster member is offline.
n Maintenance - the VSA cluster member is in maintenance mode.

n

3

4
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Capacity

View the total disk capacity on the host that runs the respective VSA
cluster member appliance.

Mgmt Address

View the management IP address of the VSA cluster member appliance.

Back End Address

View the back-end network address for the selected VSA cluster member
appliance.

Exported Datastores

View the datastores that the selected VSA cluster member exports.

Hosted Replica

View the datastore replica that the VSA cluster member appliance
manages on its ESXi host.

Host

View the host on which the selected VSA cluster member appliance
resides.

(Optional) Select a VSA cluster member appliance and view information about its properties.
VSA Virtual Machine Property

Action

Name

View the name of the selected VSA cluster member appliance.

Status

View the status of the selected VSA cluster member appliance.
n Online
n Offline

Host

View the ESXi host on which the VSA cluster member appliance resides.

Physical Capacity

View the aggregated capacity of all physical hard disks on the host.

Exported Datastores

View the datastores that the selected VSA cluster member appliance
xports.

Hosted Replica

View the datastore replica that is managed by the selected VSA member
appliance.

(Optional) View information about the VSA cluster member appliance network configuration in the
Management Network and Back End Network sections.
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View a Graphical Map of a VSA Cluster
You can view a graphical representation of the connection between the components of the VSA cluster.
Procedure
1

In the VSA Manager tab, click Map.
A graphical map of the cluster appears.

2
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View components or connections between components by selecting or deselecting the check boxes in
the Map Relationships panel.
Option

Description

Datastore to Replicas

Shows the connection between a datastore and its exported volume and
replica.

Datastore to vSphere Storage
Appliance

Shows the connection between a datastore and the two VSA virtual
machines that manage its exported volume and replica.

Replica to vSphere Storage
Appliance

Shows the connection between a VSA virtual machine and the datastore
volume that it manages.

vSphere Storage Appliance to Host

Shows the ESXi nodes and the VSA virtual machines that run on them.
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6

During the installation and operation of an VSA cluster, different errors might occur which can prevent the
correct functioning of the VSA cluster. You can take different actions to troubleshoot the errors.
This chapter includes the following topics:
n

“Collect VSA Cluster Logs,” on page 73

n

“VSA Manager Tab Does Not Appear,” on page 74

n

“VSA Cluster Member Failure,” on page 74

n

“Repair the Connection with the VSA Cluster Service,” on page 75

n

“Restart the VSA Cluster Service,” on page 75

n

“vCenter Server Failure,” on page 75

n

“Recover an Existing VSA Cluster,” on page 76

n

“Failure to Increase VSA Cluster Storage,” on page 77

Collect VSA Cluster Logs
While in operation mode, a failure might occur to the VSA cluster. You can view information about the
failure by collecting the VSA cluster logs.
Prerequisites
The VSA cluster must be installed and running to collect the logs from the Download VSA Logs button in
the upper-right corner of the VSA Manager tab.
Procedure
1

Click the VSA Manager tab.

2

In the VSA Manager tab, click Export VSA Logs in the upper-right corner.
The Export VSA Logs dialog shows a message that VSA Manager collects all logs from the running VSA
cluster members, VSA Manager, and the VSA cluster service. After it completes the collection, the
Download VSA Logs button appears.

3
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Click Download VSA Logs and save the .zip log archive in a directory on the vCenter Server system.
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VSA Manager Tab Does Not Appear
After the VSA Manager installation completes, the VSA Manager tab does not appear in the vSphere Web
Client.
Problem
The VSA Manager tab does not appear after the installation completes or between closing and re-opening
the client.
Solution
1

2

Verify that VMware Virtual Center Management Webservices is running.
a

Select Start > Run, enter services.msc, and press Enter.

b

Select VMware VirtualCenter Management Webservices and view its status in the Status column.

c

If the service is not running, right-click it and select Start.

Verify that the VSA Manager plug-in is enabled.
u

From the Home page of the vSphere Web Client, click Administration and click Plug-In
Management under Solutions.

Make sure that the status for VSA Manager is Enabled.
3

If the status is Disabled, right-click VSA Manager and select Enable.
The status of the VSA Manager plug-in changes to Enabled.

VSA Cluster Member Failure
Due to various reasons a VSA cluster member might stop responding even though the ESXi host is still
working as expected.
Problem
A VSA cluster member stops responding or powers off, and its status changes to Offline in the VSA
Manager tab.
Cause
The following reasons might contribute to the Offline status of a VSA cluster members.
n

Failure in the front-end network of the VSA virtual machine.

n

Power failure in the ESXi host that accommodates the VSA virtual machine.

Solution
n

If a VSA cluster member is not responding, right-click it and select Power > Reset.
The VSA cluster member reboots. Wait for its status to change to Online in the VSA Manager tab.

n

If the VSA cluster member is powered-off, right-click it and select Power > Start.
The VSA cluster member starts. Wait for its status to change to Online in the VSA Manager tab.

n
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If none of the steps above fix the issue, replace the VSA cluster member by using the Replace VSA
Cluster Member wizard.
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Repair the Connection with the VSA Cluster Service
In a VSA cluster with two members the VSA cluster service might become unavailable. As a result, its status
changes to Offline. You can use VSA Manager to repair the connection between the VSA cluster and VSA
cluster service.
Problem
In a VSA cluster with two members, the VSA cluster service might become unavailable.
Cause
The cause of the problem might be that the service is not running on the vCenter Server machine.
Solution
1

On the vCenter Server machine open the Services utility and verify that the VMware VSA Cluster
Service is running.

2

In the VSA Manager tab, click Repair VSA Cluster Service in the upper-right corner.

3

Verify that the VSA cluster service status changes to Online.
The status of the VSA cluster service is shown on the left side of the Cluster Properties panel.

Restart the VSA Cluster Service
If a failure occurs within a VSA cluster with two members, you might have to restart the VSA cluster service
to ensure that the VSA cluster works as expected.
The VSA cluster service is used only if you created a VSA cluster with two members.
Procedure
1

In the vCenter Server machine, select Start > Run, type services.msc, and click OK.

2

Right-click VMware VSA Cluster Service and select Restart.

The VSA cluster service starts.
What to do next
In the VSA Manager tab, verify that the status of the VSA cluster service is now Online. If the status is
Offline, click Repair VSA Cluster Service in the upper-right corner to re-establish the connection between
the VSA cluster and the VSA cluster service.

vCenter Server Failure
If your vCenter Server machine or vCenter Server installation fail permanently, the VSA cluster continues
working but you cannot manage it from VSA Manager.
Problem
If your vCenter Server machine fails, you cannot use VSA Manager to view information about the cluster or
do maintenance tasks.
Cause
A hardware component might stop working or a permanent software failure might require that you reinstall
your vCenter Server on another computer.
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Solution
1

Reinstall vCenter Server on the same machine or on another machine.

2

Configure the new vCenter Server to use the same IP address and configuration settings as the machine
that stopped working.

3

If you make frequent backups of the vCenter Server database, restore the most recent copy.

4

Install VSA Manager on the new vCenter Server machine.

5

Connect to the reinstalled vCenter Server with the client and select the VSA Manager tab.

6

Recover your VSA cluster.
The Recover VSA Cluster workflow recreates the HA cluster.

7

Verify the cluster data after the recovery completes.

8

In the inventory, drag and drop the ESXi hosts on the VSA HA cluster object.

Recover an Existing VSA Cluster
If the vCenter Server system failed and you had to recover or reinstall it together with VSA Manager, the
VSA cluster is still running but is no longer registered with vCenter Server and VSA Manager. You can use
the VSA Installer wizard to recover the running VSA cluster. Recovering the VSA cluster in VSA Manager
does not make changes to the cluster.
Prerequisites
Verify that the environment meets the VSA cluster recovery prerequisites.
n

The IP addresses of the ESXi hosts did not change

n

The VSA cluster is online and its virtual machines are still running

n

All ESXi hosts in the cluster have the same root password

n

vCenter Server is installed on the same or different computer

n

The database of the failed vCenter Server is not restored

Install VSA Manager with the new vCenter Server installation.
Create a new datacenter in vCenter Server. The datacenter name must not be VSADC as the VSA cluster
recovery workflow creates a datacenter with that name. If a datacenter with the VSADC name exists, the
recovery fails.
Procedure
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1

Open the VSA Manager tab for the new datacenter.

2

On the Welcome page of the VSA Installer wizard, select Recover VSA Cluster and click Next.

3

On the VSA Cluster Information page of the VSA Installer wizard, type the required information to
recover the existing VSA cluster and click Next.
Option

Action

VSA Cluster IP Address

Type the VSA cluster IP address.
Note If you type a wrong IP address, VSA Manager cannot recover the
VSA cluster and shows an error message.

VSA Cluster User Name

Type svaadmin.

VSA Cluster Password

Type the VSA cluster password. The default VSA cluster password is
svapass.
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Option

Action

Host User Name

Type root.

Host Password

Type the ESXi host password.

The system checks the status of the VSA cluster you are recovering. If the cluster is online, you can
proceed with the recovery. You cannot continue if the cluster is offline.
4

For the online cluster, click Next.

5

On the Verify Information page, review the information that you provided and confirm that you accept
the VSA security policy.

6

Click Recover.

7

In the confirmation dialog box, click Yes.
The Recover VSA cluster page appears.

The Recover VSA Cluster page shows the progress of the recovery task.
What to do next
After the recovery process completes, click Reconfigure to open the reconfigure network wizard. For
information, see “Reconfigure the VSA Cluster Network,” on page 65.

Failure to Increase VSA Cluster Storage
When you use the Increase Storage link to expand your VSA cluster, the operation might fail with an error
message.
Problem
After your attempts to increase the VSA cluster fail, you receive a message indicating which datastores
failed to resize and which cluster members caused the failure.
Solution
Use one the following options to correct this problem:
n

Retry the Increase Storage operation.

n

Replace the cluster member that is causing the problem, and then retry the Increase Storage operation.
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